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This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

I

t's another full house. We have Python, LibreOffice, VAX-VMS, Inkscape, Arduino (of sorts), and
an extra HowTo, from me, on the absolute basics of using Audacity. I'm no audio expert, so it's
pretty down and dirty, but that knowledge is what helps me make the Full Circle Weekly News .
Since I am now the proud owner of a BQ Aquaris M1 0 Ubuntu tablet (FHD), I thought I'd better
review it for you folks. I won't spoil it, but suffice it to say: it's not perfect, but I hope future OTA's
will make it better than it already is. Oh, and, speaking of reviews, Greg is reviewing the book
Python Crash Course from No Starch Press.
Restoring life to old machines seems to be theme for this month's Linux Labs. Alan and Charles
both discuss using Ubuntu on old machines, but for different reasons.
I had hoped to discuss OTA-1 1 in this month's issue, but it's been delayed by at least a week, so
it'll be June before it arrives.
Elmer bids us farewell with part 60 being his last LibreOffice article. It's been a pleasure to
work with him over the years, and I wish him all the best. He knows the door is always open to
return with more LibreOffice, or something else.
As ever, don't be shy about sending in articles. We need them to keep going. Show, discuss,
review. Just write it up. Include (embedded in the article) screens/photos (JPG
format) and email it to me at the address below.

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org
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Find Full Circle on:
goo.gl/FRTMl

facebook.com/fullcircle
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http://www.magzter.com/
publishers/Full-Circle

Weekly News:

http://fullcirclemagazine.org
/feed/podcast
http://www.stitcher.com/s?
fid=85347&refid=stpr
http://tunein.com/radio/FullCircle-Weekly-Newsp855064/
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Submitted by Arnfried Walbrecht

THE FULL CIRCLE
WEEKLY N EWS

N VIDIA 364.1 9 SHORTLIVED LINUX D RIVER ADDS
VULKAN 1 .0 SUPPORT,
WAYLAND FIXES

RSS:

http://fullcirclemagazine.
org/feed/podcast

for a solution from the kernel
team.

Titled “The Linux Scheduler: a
Decade of Wasted Cores,” the
paper was authored by a sextet of
researchers from the University of
he Short-Lived branch of the
British Columbia and four other
Source:
Nvidia video driver usually gets
the latest improvements and fixes, http://news.softpedia.com/news/n institutions. According to the
paper, there are four bugs in the
vidia-364-1 9-short-lived-unixbut it is not recommended to
kernel scheduler that makes some
driver-adds-vulkan-api-1
-0-supportstable users because it changes too
CPU cores stay idle even when
wayland-fixes-503325.shtml
often and new releases are not
runnable threads are waiting to be
thoroughly tested. Nvidia 364.1 9 is
dispatched to a core.
now the latest short-lived graphics
driver, and it looks like it brings
H ERE IS HOW YOU CAN FIX
Desktop users are not affected
many interesting changes.
LINUX SCHEDULE BUG
by the bug. According to a
discussion thread on Hacker News,
First, it adds support for the
arlier this month, according to the issue includes complications
Nvidia Quadro M6000 24GB and
a lecture and paper delivered
that arise when using the Linux
Quadro M5500 graphics cards.
at the EuroSys ’1 6 conference in
scheduler on multiprocessor
Then, we can see a new kernel
London, the Linux kernel scheduler systems. In certain circumstances,
module, namely nvidia-drm.ko,
has deficits that stop a multicore
the algorithm used by the
which has been engineered to
system from making proper use of scheduler to balance the load
register itself as a DRM driver with all cores for heavily multithreaded
across cores flops. For example, a
both DRM KMS and PRIME support, loads.
thread that was asleep in the past
as well as initial Direct Rendering
is woken up on an overloaded core,
Manager Kernel Modesetting (DRM
However, now a patch is
when other cores are not in use.
KMS) support.
available in a script provided by a
third party for those who are
The paper mentions one test
The Nvidia 364.1 9 short-lived
running applications that might be with apps written in the R language
graphics driver also adds a new
affected and do not wish to wait
that suggests how the issue might
RandR property called CscMatrix,
full circle magazine #1 09
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T
A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

which can be used to specify a 3x4
color-space conversion matrix. As
usual, numerous issues have been
resolved, which you can see if you
click the changelog attached at the
end of the article.

E
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arise when doing math and
statistical work in multicore Linux
environments.
The researchers say that such
bugs don’t always proclaim their
presence with a crash or a hang,
but rather via poor performance,
so they are not always noticeable.
Source:
http://www.techworm.net/201 6/0
4/can-fix-linux-schedule-bug.html

U BUNTU KYLIN 1 6.04 LTS
ARRIVES FOR THE CHINESE
LINUX COMMUNITY WITH
B OTTOM U NITY

U

buntu Kylin 1 6.04 LTS was
officially launched as part of
the massive Ubuntu 1 6.04 LTS
(Xenial Xerus) release, and it
introduces many enhancements,
updated components, new tweaks
and under-the-hood optimizations,
as well as a brand-new Unity7
design with the Launcher placed at
the bottom of the screen by
default.
Powered by the same long-term
supported kernel as Ubuntu 1 6.04

LTS, Linux 4.4, Ubuntu Kylin 1 6.04
is also an LTS release supported for
five years with critical security fixes
and software updates. The Ubuntu
Kylin development team proved to
be very ingenious this cycle, and
we need to thank them for the
ability to have the Unity Launcher
at the bottom of the screen.
Release highlights of Ubuntu
Kylin 1 6.04 LTS (Xenial Xerus)
include a more concise and userfriendly lock screen and display
manager, Ubuntu Kylin Software
Center as the default graphical
package manager, a revamped
version of the China Weather
Indicator, updated Sogou Chinese
Pinyin input method, and the latest
Kingsoft WPS office suite.
Source:
http://news.softpedia.com/news/u
buntu-kylin-1 6-04-lts-arrives-forthe-chinese-linux-community-withbottom-unity-503338.shtml

XUBUNTU 1 6.04 LTS AND
LUBUNTU 1 6.04 LTS
RELEASED, G ET THREE
YEARS OF SUPPORT
full circle magazine #1 09

X

ubuntu and Lubuntu are the
last two official Ubuntu
flavors released as part of the
massive Ubuntu 1 6.04 LTS (Xenial
Xerus) launch, and we're going to
tell you a little about their
presence.
First, we're going to tell all
about the Xubuntu 1 6.04 LTS
operating system, which had the
smallest presence of all the
Ubuntu flavors, and according to
the announcement, release
highlights include new community
wallpapers, and the replacement
of the Ubuntu Software Centre
app with the GNOME Software
graphical package manager.

http://news.softpedia.com/news/x
ubuntu-1 6-04-lts-and-lubuntu-1 604-lts-released-get-three-years-ofsupport-503348.shtml

U BUNTU MATE 1 6.04 LTS
O FFICIALLY RELEASED FOR
RASPBERRY PI 3 AND
RASPBERRY PI 2

T

he Ubuntu MATE 1 6.04 for
Raspberry Pi port, which
comes hot on the heels of Lubuntu
1 6.04 LTS for Raspberry 2, has
been in development for the last
few months. Thus, since the Beta 2
build introduced at the beginning
While still based on the LXDE
of April, the team of developers
desktop, Lubuntu 1 6.04 LTS'
behind this project have
presence was also quite small but a implemented several new tweaks
bit better, with features like
and much-needed improvements.
massive artwork improvements for
both the desktop theme and the
Among these, we can notice the
icons, various updates to most of
addition of OpenMAX IL hardware
the LXDE components, the
accelerated video playback to the
removal of the lubuntu-extraVLC Media Player software,
sessions component from the
requiring users to enable hardware
default install, and several bug
accelerated video playback via the
fixes.
"OpenMax IL" option implemented
under Tools -> Preferences ->
Source:
Video. Moreover, there is full
support for Wi-Fi and Bluetooth

5

contents ^

NEWS

technologies for the Raspberry Pi
3 Model B SBC.
Source:
http://news.softpedia.com/news/u
buntu-mate-1 6-04-lts-officiallyreleased-for-raspberry-pi-3-andraspberry-pi-2-503395.shtml

U BUNTU 1 6.04 B RINGS
M ORE PRIVACY AND B IG
CHANGES TO THE D ESKTOP

T

he release of Ubuntu 1 6.04
last week is good news for
computer users who are upset
over the recent development of
Microsoft turning Windows into an
operating system that is
essentially spyware. As an opensource Linux distribution, Ubuntu
is a great operating system for
users concerned about privacy.
This marks the 24th release of
the Ubuntu operating system,
which has become perhaps the
most popular Linux distribution in
the world. Ubuntu 1 6.04 —
codenamed Xenial Xerus — is also
the sixth Long Term Support (LTS)
release, meaning it will receive
free security updates and support
for five years. Canonical, the UK

software company which sponsors
Ubuntu, has continued to show its
commitment to providing a solid,
smooth, reliable, open-source
operating system for the desktop
even while working toward
convergence of the desktop, phone
and tablet into one seamless
operating system.

LinuxONE is the heart of IBM's
hybrid cloud efforts. At the
OpenStack Summit, Angel Diaz, VP
of IBM Cloud Architecture &
Technology, said LinuxONE with
Ubuntu and OpenStack can deliver
the "speed and flexibility that
businesses need to make the
Benjamins money."

For Windows users looking for a
privacy-minded operating system,
this means that 1 6.04 stands on a
solid foundation and should prove
to be a good daily-driver.

Mark Shuttleworth, founder of
Canonical and Ubuntu, added that
"Ubuntu is all about enabling
users, such as Netflix, to create
work easily without friction. On
LinuxONE, you can just use Ubuntu
without needing to know anything
about the mainframe
architecture."

Source:
http://www.thenewamerican.com/
tech/computers/item/23037ubuntu1 6-04-brings-more-privacyand-big-changes-to-the-desktop

STICK

The Fathom contains the Myriad
2 MA2450 VPU paired with 51 2MB
of LPDDR3 RAM. The Myriad 2 is
the chip found in the previously
mentioned DJI and FLIR products.
It's able to handle many processes
simultaneously, which is exactly
what neural networks call for.
Because it's specifically designed
for this -- its architecture is very
different from the GPUs and CPUs
that typically handle processing -it offers a lot of grunt without
requiring much power. It can
handle up to 1 50 gigaFLOPS (1 50
billion floating-operations per
second) while consuming no more
than 1 .2 watts.

ovidius chips have been
showing up in quite a few
products recently. It's the company
that helps DJI's latest drone avoid
obstacles, and FLIR's new thermal

Unlike Tegra's solutions for
deep learning, the Fathom isn't a
standalone system. The idea is you
plug it into the USB 3.0 port of any
system running Linux to get a "20-

Source:
http://www.zdnet.com/article/ubu
ntu-linux-and-openstack-cloudcome-to-ibm-servers/

U BUNTU LINUX AND
O PEN STACK CLOUD COME TO
IBM SERVERS
ARTIFICIAL INTELLIGENCE
NOW FITS INSIDE A USB
ast year, IBM introduced

L

LinuxONE, a new pair of IBM
mainframes along with Linux and
open-source software and services.
These new systems are the
LinuxONE Emperor, which built on
the IBM z1 3 mainframe and its
little brother, Rockhopper.
full circle magazine #1 09

camera automatically spot people
trapped in a fire, all through deep
learning via neural networks. It
also signed a deal with Google to
integrate its chips into as-yetunannounced products. Now, the
chip designer has a product it says
will bring the capacity for powerful
deep learning to everyone: a USB
accessory called the Fathom
Neural Compute Stick.

M
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30x performance improvement in
neural compute." You can use the
Fathom to rapidly prototype neural
networks, moving to something
with a lot more power once you're
ready to deploy.
Source:
http://www.engadget.com/201 6/0
4/28/movidius-fathom-neuralcompute-stick/

of information, that the Linux 3.1 2
series will be supported until 201 7
because it is used in SUSE Linux
Enterprise 1 2.
Source:
http://news.softpedia.com/news/li
nux-kernel-3-1 2-59-lts-out-nowwith-crypto-networking-fixesupdated-drivers-503495.shtml

M OZILLA FIREFOX 46.0
LINUX KERNEL 3.1 2.59 LTS LANDS IN ALL SUPPORTED
O UT N OW WITH CRYPTO & U BUNTU OSES WITH GTK3
N ETWORKING FIXES,
I NTEGRATION
U PDATED D RIVERS

L

M

ozilla Firefox 46.0 is a pretty
inux kernel developer Jiri Slaby
small release of the popular
announced the availability of
web browser, which is used by
the fifty-ninth maintenance
default in numerous GNU/Linux
release of the long-term
operating systems, including
supported Linux 3.1 2 kernel series, Ubuntu. It's worth mentioning that
urging all users to update as soon it only brings improved security to
as possible.
the JavaScript JIT (Just In Time)
compiler, more WebRTC
Looking at the appended
performance and stability
shortlog, we can notice that Linux enhancements, and various
kernel 3.1 2.59 LTS is here to patch security fixes.
various security issues that have
been discovered since the previous
Of course, there were also a
point release, version 3.1 2.58,
few other minor changes, such as
which was announced two weeks
better rendering for scaled SVGs
ago, along with an important piece (Scalable Vector Graphics) that use
full circle magazine #1 09

a mask and a clip, improvements to
the screen reader behavior with
blank spaces for Google Docs,
support for the
document.elementsFromPoint
HTML5 element, and HKDF
support for the Web CryptoAPI.
Mozilla Firefox 46.0 web
browser has finally been
introduced for all supported
Ubuntu Linux operating systems,
including Ubuntu 1 6.04 LTS (Xenial
Xerus), Ubuntu 1 5.1 0 (Wily
Werewolf), Ubuntu 1 4.04 LTS
(Trusty Tahr), and Ubuntu 1 2.04 LTS
(Precise Pangolin), so please
update as soon as possible.
Source:
http://news.softpedia.com/news/
mozilla-firefox-46-0-lands-in-allsupported-ubuntu-oses-with-gtk3support-503489.shtml

O RACLE RELEASES
VIRTUALB OX 5.0.20 WITH
FIXES FOR LINUX KERNEL
4.5, SMALL CHANGES

of its acclaimed open-source and
cross-platform virtualization
software.
According to the release notes,
Oracle VirtualBox 5.0.20 is a pretty
small release that comes only one
and a half weeks after the previous
maintenance build, VirtualBox
5.0.1 8, which introduced initial
support for the upcoming Linux 4.6
kernel.
Changes in today's VirtualBox
5.0.20 release include more fixes
for the Linux kernel 4.5 series,
especially when the
CONFIG_NET_CLS_ACT variable is
enabled, support for listing
processor features on
VBoxManage's list hostinfo, TCP
support in the DNS proxy feature,
as well as better handling of portforwarding rules.
Source:
http://news.softpedia.com/news/o
racle-releases-virtualbox-5-0-20with-fixes-for-linux-kernel-4-5small-changes-503525.shtml

O

racle has announced the
release of VirtualBox 5.0.20,
yet another maintenance version
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ELEMENTARY OS 0.4 "LOKI "
TO B E B ASED ON U BUNTU
WHAT’S ON TAP FOR LINUX
1 6.04, PROMISES B IG N EW CONTAINER TECHNOLOGY IN
FEATURES
201 6

N

ow that Canonical has
launched its most anticipated
Ubuntu release, the Xenial Xerus,
a.k.a. Ubuntu 1 6.04 LTS, it looks
like the elementary OS community
has flooded the forums with
questions about the release date
of the elementary OS 0.4 "Loki"
operating system, which has now
been finally confirmed as being
based on Ubuntu 1 6.04.
Elementary OS 0.4 "Loki" is
coming, and it promises big new
features, which have not yet been
revealed by the team of hardworking people behind what was
previously known as the "most
beautiful Linux distro." However,
we do know there'll be better
HiDPI support and, of course, the
integration of the Birdie Twitter
client.
Source:
http://news.softpedia.com/news/e
lementary-os-0-4-loki-to-be-basedon-ubuntu-1 6-04-promises-bignew-features-503536.shtml

W

hite hot interest in
containers has been driven
by cloud computing’s demand to
simplify deployment, streamline
time to production, and
automatically deliver the resources
an application needs. Linux
containers provide that in a nice
package: a simple tool for
developing, testing and delivering
an application to the end user.
Containers are designed to
make it easier and quicker for
developers to create complete
application operating
environments. Gone is the painful
validation process of traditional
application deployments that
require developers to identify the
minimum system requirements
needed to run the application.
There are other important
benefits. Linux containers package
just about any type of server
application to run everywhere – on
your desktop, in a cloud, or
anywhere Linux is available –
full circle magazine #1 09

regardless of kernel version or
Linux distribution. Containers also
can have a considerably smaller
footprint than VMs, which means
your systems can see higher
densities and run more cost
effectively with containers than
with VMs on the same host.

limit a while back anyway, so
they're making it official according
to OMG!Ubuntu! The new limit is
up from one gigabyte to two.
OMG!Ubuntu! also posted of
Ubuntu in the wild, April 201 6
edition. And finally, one more
Ubuntu note, Jesse Smith said
today of 1 6.04, "Ubuntu 1 6.04 is a
very nice release."

Source:
http://www.networkworld.com/art
Source:
icle/3065049/cloudcomputing/what-s-on-tap-for-linux- http://ostatic.com/blog/nocontainer-technology-in-201 6.html ubuntu-back-doors-windows-andmac-migrations

N O U BUNTU B ACK D OORS,
WINDOWS AND M AC
M IGRATIONS

M

ark Shuttleworth said in an
interview with eWeek.com
today, "We will never backdoor
Ubuntu." He said, "We don't do
encryption to hide things; we do
encryption so we can choose what
to share. We will never weaken
encryption." Watch the full
interview for more on Ubuntu
development, in particular plans
for Mir. Speaking of Ubuntu,
another announcement coming out
of the UOS is that the size limit of
Ubuntu desktop image will be
raised. Releases surpassed the

8

B EAUTIFUL SIMPLICITY
LINUX 1 6.04 OS ARRIVES,
B ASED ON LXPUP AND THE
LXDE D ESKTOP

S

implicity Linux 1 6.04 is
distributed in three main
editions, namely Desktop, X, and
Mini. The distribution has been in
development for the past three
months, since February, when it
was initially released as Simplicity
Linux 1 6.01 .
Since then, the development
team behind the Simplicity Linux
project has managed to seed Alpha
contents ^
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and Beta builds to early adopters
and public beta testers who
volunteered to help them polish
the final release of the operating
system before it hit the streets,
which happened on May 2, 201 6,
after a small delay.
Being based on the excellent
and lightweight LXPup GNU/Linux
distribution, and built around the
LXDE desktop environment,
Simplicity Linux 1 6.04 is powered
by a kernel from the 4.0 series
(Linux 4.0.4) on the Desktop and
Mini editions, and Linux kernel
4.4.5 LTS on the X flavor, which is
the experimental branch of the OS,
where all the bleeding-edge stuff
happens before it lands in the
more stable Desktop and Mini
editions.
Source:
http://news.softpedia.com/news/b
eautiful-simplicity-linux-1 6-04-osarrives-based-on-lxpup-and-thelxde-desktop-503654.shtml

HP LINUX I MAGING AND
PRINTING 3.1 6.5 SUPPORTS
U BUNTU 1 6.04 LTS AND
D EBIAN 8.4

T

he team of developers behind
the HPLIP (short for HP Linux
Imaging and Printing) project,
announced the availability of the
fifth maintenance build in the 3.1 6
stable series of the software.
Today's release of HP Linux
Imaging and Printing 3.1 6.5 is
proof that the project is getting
stronger with each day, offering
you support for more HP printers
than any other proprietary
software. Newly supported HP
printers in HPLIP 3.1 6.5 include HP
OfficeJet 200 mobile printer series
and HP OfficeJet Pro 871 0 all-inone printer.

CANONICAL ANNOUNCES
THE AVAILABILITY OF
U BUNTU CORE FOR
S AMSUNG ARTIK 5 AND 1 0

T

hibaut Rouffineau, an IoT &
Ubuntu Core evangelist, has
announced the availability of
Canonical's Ubuntu Core operating
system for Samsung ARTIK 5 and
1 0 IoT (Internet of Things)
platforms.

Source:
http://news.softpedia.com/news/c
anonical-announces-theavailability-of-ubuntu-core-forsamsung-artik-5-and-1 0503744.shtml

M 23 ROCK 1 6.2 LINUX
D EPLOYMENT TOOL ADDS
SUPPORT FOR U BUNTU
1 6.04 LTS CLIENTS

m

23 Rock 1 6.2 comes exactly
Those of you who have been
three months after the
waiting to get their hands on the
release of the Rock 1 6.1 version,
Ubuntu Core developer images for which was a small update
the Samsung ARTIK 5 and Samsung introducing support for the
Furthermore, the HP OfficeJet ARTIK 1 0 boards should know that Univention Corporate Server (USC)
Pro 871 5 all-in-one printer, HP
they are available for download for and Linux Mint 1 7.3 "Rosa"
OfficeJet Pro 8740 all-in-one
free from the
operating systems, and it looks like
printer, HP OfficeJet Pro 8720 all- https://developer.ubuntu.com/en/s it includes some very interesting
in-one printer, HP OfficeJet Pro
nappy/start/samsung-artik-iotadditions, along with the usual bug
8725 all-in-one printer, HP LaserJet modules/ website.
fixes and improvements.
Pro M501 n, and HP LaserJet Pro
M501 dn printers are also
These Ubuntu Core images will
Probably the most important
supported by the HP Linux Imaging give developers access to a
new feature added in the m23
and Printing 3.1 6.5 release.
number of technologies of the two Rock 1 6.2 update is the support for
Samsung ARTIK IoT boards,
Canonical's recently released
Source:
including but not limited to Wi-Fi
Ubuntu 1 6.04 LTS (Xenial Xerus)
http://news.softpedia.com/news/h and Bluetooth, and they can also
operating system, which means
p-linux-imaging-and-printing-3-1 6- be used as a starting platform to
that you can now use m23 to make
5-supports-ubuntu-1 6-04-lts-andbuild their next Internet of Things large-scale deployments of this OS.
debian-8-4-50371 2.shtml
applications and devices.
full circle magazine #1 09
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The devs have also noted the
fact that a set of desktop
environments is available too for
Ubuntu 1 6.04 LTS deployments.
These include the popular Unity, as
well as KDE, Xfce, LXDE, and
MATE. It also looks like they had to
make a lot of adjustments to the
systemd init system
implementation of Ubuntu 1 6.04
LTS, which didn't work as expected.
Source:
http://news.softpedia.com/news/
m23-rock-1 6-2-linux-deploymenttool-adds-support-for-ubuntu-1 604-lts-clients-503784.shtml

U BUNTU 1 6.1 0 (YAKKETY
YAK) WILL SOON B E
POWERED BY LINUX KERNEL
4.6

A

t the end of April, the Ubuntu
developers have announced
that the development of the next
major release of the Debian-based
operating system, Ubuntu 1 6.1 0
(Yakkety Yak), is officially open,
which means that they will start
uploading new package versions,
sync the repositories with
upstream, fix potential issues, and

rebase the kernel packages, as
everything right now in Yakkety is
based on Xenial.

The FSF is best known for its
unrelenting advocacy for software
unencumbered by patents and
protected for future use by the
The Ubuntu 1 6.1 0 (Yakkety Yak) GPL, as embodied in software like
daily build live ISO images have
the Linux kernel and the GNU
been made available for download toolchain. The gNewSense Linux
immediately after the April 21 st
distribution is assembled with the
release of Ubuntu 1 6.04 LTS (Xenial FSF's goal in mind of having no
Xerus), for early adopters, but
dependencies at all on proprietary
most, if not all, of the packages,
binaries or other components that
have the same versions as those in aren't compatible with the GPL.
Ubuntu 1 6.04 LTS, including the
kernel. But it looks like that will
Earlier gNewSense releases
change soon, and Ubuntu 1 6.1 0
used Ubuntu as the base, but the
will be powered by Linux kernel
project switched to Debian (from
4.6.
which Ubuntu was derived)
because it already performs a lot
Source:
of the work needed to remove
http://news.softpedia.com/news/u GPL-incompatible elements.
buntu-1 6-1 0-yakkety-yak-will-soonbe-powered-by-linux-kernel-4-6Source:
50381 2.shtml
http://www.infoworld.com/article/
3067280/open-source-tools/freeas-can-be-gnewsense-is-true-gnulinux.html
FREE AS CAN BE:

G N EWS ENSE IS TRUE GNU
LINUX

T

he Free Software Foundationsupported Linux distribution
gNewSense is finally out in its
fourth revision after a two-plusyear development cycle.
full circle magazine #1 09

B LACK LAB SOFTWARE
ANNOUNCES B LACK LAB
CLOUDBOOK PC AS A
CHROMEBOOK
REPLACEMENT
10

B

lack Lab NetOS is the
company's brand-new cloudoriented, Web-centric Linux kernelbased operating system, which
Black Lab Software considers is the
perfect ChromeOS replacement. In
the same manner, the Black Lab
Cloudbook computer comes as an
alternative to Chromebooks.
Black Lab Software's NetOS
operating system is based on
Ubuntu Linux, but it differs from
the main Black Lab Linux
distribution in the way that it only
uses cloud applications, just like
Google's ChromeOS. However,
users will also have direct access to
the main Ubuntu software
repositories to install any of the
available packages.
The Black Lab NetOS operating
system is built around the Xfce
4.1 2 desktop environment and
includes popular applications like
VLC Media Player, Google Chrome,
and Skype, along with numerous
Web Apps, such as Twitter,
Facebook, Facebook Messenger,
Netflix, Hulu, Outlook, Microsoft
Office Online, or Slack.com.
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Source:
Limits are a critical application
http://news.softpedia.com/news/b tuning parameter. Cloud Docker
lack-lab-software-announces-black- services have their own mechanism
lab-cloudbook-pc-as-afor configuring ulimits.
chromebook-replacement503876.shtml
Source:
http://www.computerworld.com/ar
ticle/3067303/cloudCONFIGURING LINUX USAGE computing/how-to-configuringlinux-usage-limits-with-docker-andLIMITS WITH D OCKER AND
aws-ecs.html

AWS ECS

L

inux has become a dominant
OS for application back ends
and micro-services in the cloud.
Usage limits (aka ulimits) are a
critical Linux application
performance tuning tool. Docker is
now the leading mechanism for
application deployment and
distribution and AWS ECS is one of
the top Docker container services.
It's more important than ever for
developers to understand ulimits
and how to use them in Linux,
Docker and a service like AWS ECS.

LINUX KERNEL 4.5.4 I S O UT,
B RINGS AMDGPU, ARM,
I NTEL I 91 5, WIRELESS, X86
U PDATES

K

ernel developer Greg KroahHartman announced the
release of the fourth maintenance
build in the latest stable and most
advanced Linux 4.5 kernel branch.

While not many GNU/Linux
operating systems have adopted
Linux kernel 4.5, its development
The purpose of ulimits is to
cycle continues at a fast pace,
limit a program's resource
introducing more and more
utilization to prevent a runaway
improvements, security patches,
bug or security breach from
bringing the whole system down. It and new capabilities. According to
is easy for modern applications to the appended shortlog, which also
exceed default open file limits very includes the diff from the previous
maintenance release, Linux 4.5.3,
quickly.
full circle magazine #1 09

the new update changes a total of
97 files, with 600 insertions and
238 deletions.
The biggest changes in Linux
kernel 4.5.4 are updated drivers, in
particular for things like GPU
(mostly Intel i91 5 and AMDGPU),
ACPI, ATA, CLK, CPUFreq, CPUIdle,
general-purpose input/output
(GPIO), HID, iiO, InfiniBand,
LightNVM, MD, MFD, NVDIMM,
NVMEM, PWM, SCSI, SoC, USB,
Xen, and networking
Source:
http://news.softpedia.com/news/li
nux-kernel-4-5-4-is-out-bringsamdgpu-arm-intel-i91 5-wirelessx86-updates-503966.shtml

CANONICAL PUSHES N EW
FEATURES INTO THE SNAPPY
I NTEGRATION FOR U BUNTU
1 6.04 LTS

C

anonical's Zygmunt Krynicki
has announced that a new
version of the snapd tool has been
pushed to the stable repositories
of Ubuntu 1 6.04 LTS.
snapd 2.0.3 is the latest and
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most advanced version of the tool
used in the latest Ubuntu 1 6.04 LTS
(Xenial Xerus) operating system to
interact with the Snappy
infrastructure of Ubuntu Core, a
variant of the Ubuntu Linux OS
designed for embedded and IoT
devices.
The list of changes
implemented in snapd 2.0.3
continues with BlueZ interface
improvements, the removal of the
unused SetProperty function and
D-Bus code, the addition of short
and long description to snapd's
man-page, improvements to the
handling of snap sideload form, as
well as re-enablement of several
integration tests.
Source:
http://news.softpedia.com/news/c
anonical-pushes-new-featuresinto-the-snappy-integration-forubuntu-1 6-04-lts-50401 4.shtml

U BUNTU -B ASED E XTON |OS
LINUX D ISTRIBUTION N OW
SHIPS WITH MATE 1 .1 4,
VLC 2.2.3

E

arlier this week, we reported
on the release of a new build
contents ^
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of the Ubuntu-based Exton|OS
Linux distribution, version 1 6051 2,
which was rebased on Ubuntu
1 6.04 LTS (Xenial Xerus).
However, it was a bit strange
that the distro shipped with an
older version of the MATE desktop
environment, a clone of the oldschool GNOME 2 (also known as
GNOME Classic) graphical
interface, version 1 .1 2.7, despite
the fact that MATE 1 .1 4 was
released last month.

N EW ARDUINO SRL SBC
MERGES ARDUINO, WI FI ,
AND LINUX

A

rduino Srl’s new “Arduino
Industrial 1 01 ” SBC includes
Arduino circuitry and I/O, along
with a soldered-on WiFi module
that runs Linino Linux.

Last November, Arduino Srl
promised an Arduino Industrial 1 01
carrier board for Dog Hunter’s
WiFi-enabled Chiwawa module,
Therefore, at the request of the which is supported by the
OpenWrt-based Linino Linux
community, Arne Exton had to
upgrade the MATE package to the distribution. Arduino has now
unveiled the resulting product: a
latest stable branch, version
$40, sandwich-style single board
1 .1 4.0, which, unfortunately, he
computer with a soldered-on,
had to build from the freely
distributed sources. The reason for Arduino-branded version of the
Chiwawa module, along with Linino
that is because it looks like the
MATE 1 .1 4 desktop environment is Linux support.
not yet available in the main
The sandwich-style Arduino
repositories of Ubuntu 1 6.04 LTS.
Industrial 1 01 SBC, which includes
the Chiwawa LGA WiFi module
Source:
http://news.softpedia.com/news/u soldered on-board, is currently
listed at Arduino Srl’s shipping
buntu-based-exton-os-linuxdistribution-now-ships-with-mate- page for 35 Euros ($40).
1 -1 4-vlc-2-2-3-504071 .shtml
Source:
http://hackerboards.com/newarduino-srl-sbc-merges-arduinowifi-and-linux/
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U BUNTU B UDGIE 1 6.1 0
N OW IN D EVELOPMENT,
B RINGS N EW B OOT SPLASH ,
WELCOME SCREEN

B

udgie-Remix (soon to become
Ubuntu Budgie) developer
David Mohammed has informed
about the availability of the
project's first-ever newsletter for
the community.

Furthermore, a Welcome to
Budgie-Remix/Ubuntu Budgie app
will be available soon for the
upcoming Budgie-Remix 1 6.04.1
release, as well as in the final
Budgie-Remix 1 6.1 0 release, which
the team hopes to rename to
Ubuntu Budgie if the distribution is
accepted as an official flavor, which
Mark Shuttleworth himself said he
would endorse.

Source:
http://news.softpedia.com/news/u
buntu-budgie-1 6-1 0-now-inThe newsletter is called Budgie- development-brings-new-bootRemix Roundup, and the first
splash-welcome-screeninstallation is now live on the
504087.shtml
project's website, informing users
about the latest innovations
implemented in the operating
system, whose main design goal is LINUX 4.6 TARGETS MOBILE
WITH ARM, TOUCH SUPPORT
to give users an officially
recognized Ubuntu flavor built
side from security
around the Budgie desktop from
improvements, version 4.6 of
the Solus Project.
the Linux kernel, released over the
weekend, offers enhancements for
From the newsletter, it looks
ARM processors and touchscreens.
like there are a few interesting
things that are coming to BudgieEmbedded ARM support in the
Remix very soon, targeting both
upgrade
features backing for 1 3
the stable Budgie-Remix 1 6.04 and
SoCs (system on a chip), including
the now-in-development BudgieRemix 1 6.1 0 release. Among them systems from Allwinner, LG,
Qualcomm, and Broadcomm. WiFi
is a new boot splash screen for
routers, the Nexus 7 smartphone,
Plymouth.

A
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and the Raspberry Pi
nanocomputer, all will have
improved support for their boards,
according to the Linux Foundation.
The new version corrects an
Infiniband interface problem as
well. Linux creator Linus Torvalds
said earlier this month that few
would be affected by this problem
anyway, and a workaround had
been available.

aware from our previous coverage,
Snappy Ubuntu Core is a slimmeddown version of the Ubuntu Linux
operating system, engineered by
Canonical for deployments on a
broad range of embedded and IoT
(Internet of Things) devices, such
as Raspberry Pi single-board
computers.

Currently, Canonical provides
developers and IoT enthusiasts
with binary images of the Snappy
Source:
Ubuntu Core operating system
http://www.infoworld.com/article/ only for the Raspberry Pi 2 SBC,
3071 1 1 3/linux/linux-46-targetsbut images for the recently
mobile-with-arm-touchreleased Raspberry Pi 3 Model B
support.html
are in the works and will be
released later this year, most
probably along with the Snappy
Ubuntu Core 1 6 build.

U BUNTU CORE N OW READY
FOR S CREENLY, A D IGITAL
SIGNAGE SOLUTION FOR
RASPBERRY PI

C

anonical has announced a
partnership with Screenly to
bring the Snappy Ubuntu Core
operating system to the world's
most popular digital signage
solution for the Raspberry Pi.

Screenly is the most popular
digital signage solution for the
Raspberry Pi, and it looks like they
recently joined forces with
Canonical to build their
infrastructure around the Snappy
Ubuntu Core operating system,
offering their customers a secure,
stable, easy-to-use, robust, and
simple-to-manage digital signage
platform for Raspberry Pi boards.

As many of you are already
full circle magazine #1 09

focusing on privacy.
Source:
http://news.softpedia.com/news/u
One of the most unusual
buntu-core-now-ready-forscreenly-a-digital-signage-solution- features of the Librem 1 0 and
Librem 1 1 tablets will be “privacy
for-raspberry-pi-504200.shtml
kill switches,” which are hardware
buttons that will disconnect the
webcam, microphone, WiFi, and
PURISM INTRODUCES
Bluetooth.

PRIVACY-FOCUSED, LINUX
TABLETS FOR $599 AND UP

P

urism is expanding its line of
Linux-based computers with
an emphasis on security, privacy,
and open source software. The
company’s new Librem 1 0 is a
Linux-based tablet with a 1 0 inch
display and a starting price of
$599, while the Librem 1 1 is a
higher-powered model with a
bigger screen and a starting price
of $999 for early backers of an
Indiegogo crowdfunding campaign.
Both tablets are expected to ship
starting in September.

Source:
http://liliputing.com/201 6/05/puris
m-introduces-privacy-focusedlinux-tablets-599.html

Purism has been running
crowdfunding campaigns for Linuxbased laptops for a few years, but
the company has sort of shifted its
sales pitch a bit in the past year or
so. Instead of promising a
completely open experience (since
the BIOS typically uses proprietary
blobs), the company is instead
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CO M M AN D & CO N Q U ER Ra spberry Pi M od el 3 Setu p

Written by Lucas Westermann

’ve always been a fan of
electronics - be it Arduino, fullon computers, or something like a
Raspberry Pi. However, I always try
to balance out my purchases with
actual need - which means I have
never owned a Raspberry Pi. Until
now. I recently ordered a model 3
off Amazon (in a complete bundle
with a case, power supply and
heatsinks - the SD card was
missing, but as I own many of
them, it wasn’t necessary). The
intended use for this Raspberry Pi
was to connect it to our older
Brother MFC-230C printer - which
is USB only. There were two
reasons for this - firstly, heading to
the office to manually connect a
USB printer was a pain, and
secondly, I wanted some method
with which I could enable Google
Cloud Print. For those who don’t
know - Google Cloud Print is a
service that allows printing from
android tablets/phones and
chromebooks to a printer
connected to another computer.
The small form-factor, and built-in
wireless, in the model 3 made this
a terrific way to connect the
printer to our LAN – without

having to leave a desktop
computer or laptop running all the
time.

NOOBS installer from the
Raspberry Pi website to the SD
card.

any sensors (for use with lmsensors), I can’t make any
temperature comparisons.

The main reason I selected this
kit was because this bundle
shipped with Amazon Prime – the
other bundles had additional
shipping costs.

NOOBS installer:
https://www.raspberrypi.org/down
loads/noobs/

STEP 0: ASSEMBLY & PREP

WHAT ARE YOU COVERING ?
I’m going to focus on the setup
of the Raspberry Pi (RPi) this
month. Once I’ve given myself
sufficient time to test out the
CUPS setup and Google cloud
print, I will follow this article up
with those exact steps.

WHAT DO I NEED?
You’ll need a Raspberry Pi (and
an SD card that is >= 4GB), a
keyboard, a mouse, and a monitor.
The last 3 items you’ll need only
for the actual installation of
raspbian - everything else can be
done via SSH or VNC later.
Logically, you’ll also need some
device to download and copy the
full circle magazine #1 09

NOTE 1 : There is also a manual

installer, but I focused on the most
typical use-case.

NOTE 2: There are torrents as well
as direct downloads - but the
torrents failed to work in rtorrent.

H EATSINKS - DO I NEED
THEM ?
Heatsinks shouldn’t really be
necessary at all - most people
agree that even under the most
extreme conditions, the RPi will be
fine without. However, heatsinks
may be beneficial for me, as the
RPi will probably be operating in a
slightly stuffy room, with a high
chance of direct sunlight via the
window. Heatsinks may help keep
the RPi a little cooler in these
positions. As the RPi seems to lack
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I can’t offer exact instructions
here, as it all depends on your case
(or lack thereof). It shouldn’t be a
difficult process.
For the SD card, the official site
recommends a tool for Windows or
Mac. But if you’d rather do it by
hand, the SD card just seems to
need to be FAT32 (should be the
standard for any size less than and
including 32GB), or FAT1 6.
Unfortunately, any SD card that is
> 32GB will be exFAT by default. In
any case, I recommend
reformatting just to be safe. After
that, copy all the extracted files
from the archive onto the SD card.
Eject it, and insert it into the
underside of your RPi.

STEP 1 : I NSTALLATION
Once the case is set up, and the
SD card ready, you’ll want to
contents ^
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connect your peripherals, and then
boot the device (by plugging in the
power supply).
The RPi will then boot to a very
basic screen. You can either
connect to the internet and
download/install something other
than Raspbian - or just select
Raspbian and choose “Install”
(Recommended). I’ve used
Raspbian for this project. After
that, you’ll need to just wait out
the installation.

STEP 2: B OOTED UP - NOW
WHAT ?

added the following line directly
above the ssid line:
Interface wlan0

This tells dhcpcd to apply the
following settings only for the
wireless interface - so ethernet
runs normally on DHCP, and my
wireless will use the static IP I
chose when connected to my home
network. Other wireless networks
should default back to DHCP (so
you’ll never run into the issue that
the RPi is assuming the wrong
subnet). I have yet to test the RPi
with another wireless network.

Once you have your IP reserved
The first thing I did was connect in your router, or statically
my wireless, and tried to set a
assigned by the RPi, you’re ready
static IP (as my router doesn’t
to disconnect your
allow reserving IP addresses). The keyboard/mouse/monitor, and
GUI tool seems to just add an entry switch to SSH (if you prefer). I’ll
into /etc/dhcpcd.conf with ssid
also cover installing tightvnc and
information. This does seem to
using that, so you have access to
work - but resulted in the issue
the GUI apps.
that the static IP was used for
whatever interface came up first - S TEP 2.1 : TIGHT VNC
so if I was using ethernet, it was
used there instead (which
TightVNC is a VNC (Virtual
shouldn’t be the case as it lacks an Network Computing) client that is
SSID). In order to solve this (as I
offered in the Raspbian repos. To
want ethernet to run via DHCP install it just run:
that way I can connect it directly to
a laptop for debugging), I simply
full circle magazine #1 09

sudo apt-get install
tightvncserver

too long - and if it is, just stop
typing it after 8 characters.

Once it’s installed, simply start
it by running the command:

STEP 2.2: AUTOSTART

tightvncserver

This should result in some
information in the terminal, telling
you there is a new ‘X’ desktop. To
save resources, I recommend
killing the X session on :0, with:
service lightdm stop

STEP 2.1 .1 : CONNECTING
If you use vncviewer on a Linux
machine, just using the IP followed
by the display number, you’ll be
fine. Such as 1 92.1 68.0.1 5:1 . If
you’re trying to connect using OS
X’s integrated screen sharing
application, it will need to be a
port - 5900 = :0, 5901 = :1 , etc. So
1 92.1 68.0.1 5:5901 would work
there. I haven’t tested a
connection on Windows, but one
of the two options above should
work.
If you set a password, keep in
mind that RPi truncates passwords
to 8 characters - so if a password
isn’t working, make sure it’s not
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I used the Raspberry Pi
Configuration tool to boot
automatically into the CLI - as I
only need SSH access, and the
occasional VNC call.
If you want to automatically
start a VNC session, I would
recommend looking at the official
documentation:
https://www.raspberrypi.org/docu
mentation/remote-access/vnc/

STEP 3: APPLICATIONS
Depending on what you want to
do with the RPi, you may need to
install other packages. In my case, I
need to install the packages
chromium-inspector (chromium
browser - required for Cloud Print),
and cups (for sharing the printer
normally).
There are various articles out
there for exact steps, so here are
just a list of a few things people
may want to install/enable:
• Bittorrent Sync (for sharing files).
• Bluetooth (requires various
contents ^

COMMAND & CONQUER
packages - such as bluez bluezhcidump, bluez-tools, blueman,
etc). As this depends on whether
you want GUI tools or not, I’d
recommend following a guide that
installs just what you need.
• LAMP - for running a web server.
• Docker - I’m not sure how well
Docker would run on an RPi, but of
the virtualization options I can
think of, it would probably offer
the best performance.
• Samba (for using the RPi to share
a USB hard drive on the network).

STEP 4: D EBUGGING
If, for some reason, your RPi
isn’t working properly, you have
two options:
• Connect a monitor, keyboard,
mouse and/or ethernet
connection.
• Use SSH or VNC to debug issues.
Naturally, the first option can
be difficult to achieve, depending
on where you are, and where the
RPi is set up. However, it is by far
the least complicated to actually
implement.
For option 2: It’s not going to
be an issue as long as your RPi is
actually connected to a network,

and you know the IP (if it isn’t on a
static IP you assigned, check your
router, as it may have picked up a
fallback DHCP IP). If you can find
the IP, then you shouldn’t have any
other issues connecting via SSH or
VNC.
If, however, the RPi isn’t
connected to the network
(because it’s a new wireless
network, for example), then you’ll
typically need to connect it via
ethernet, or use a monitor,
keyboard, and mouse to connect to
the new network. If you’re lazy and
want to make life easier for you you can simply set up a DHCP
server on your laptop (on both
Windows and Linux you’ll need to
install and set up some form of
DHCP server, but OS X offers that
option by default under System
Preferences -> Sharing -> Internet
Sharing). After the DHCP server is
running, you can just connect an
ethernet cable to the RPi from
your laptop, and then start the RPi
(it may work on an already running
system, but I have tested it only
from an off state). From your
laptop, you should be able to get a
list of clients and their IPs - this
depends on the server and OS
you’re using. Once you get the IP
of the client, you can just connect
full circle magazine #1 09

via SSH or VNC, and work from
there.
That about wraps it up for this
month. If you have any issues, or
questions, feel free to email me at
lswest34+fcm@gmail.com. The
same is true for anyone who has
suggestions or requests for
articles - ideas are always
welcome!

EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporter
(Arnfried) is posting regular
news updates to the main Full
Circle site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.
Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!
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H OW-TO

Written by Greg D. Walters

ast month, I suggested you get
a number of parts and if you
were able to get them, I hope that
it didn’t cost you too much. If you
haven’t gotten them, then follow
along as best you can, and if there
is a particular project you want to
try, then get those components
that are needed. I’m trying to do
this on as little cash outlay for
either you or me as possible.
Frequently, you can recycle many
of the items from older electronic
items; many can be found at a local
thrift store for pence on a pound.
(Hopefully I got that one right. We
say pennies on a dollar here, so at
least give me an “F” for effort…
ok?)
As I was laying last week,
waiting for some surgery, I was
thinking that if someone were to
come up to me and ask directly
why I’m doing this, what my
answer would be. Before the
wonderful chemicals they pumped
into my body to make the process
less horrible, I realized that the
REAL reason is multi-part. First, is
to create excitement in “nonprogrammers” when doing things

P yth on I n Th e Rea l World - Pt 65

that seemingly could not be done
without a ton of training. Secondly,
is to show that the newer
technology, like the Raspberry Pi
and the Arduino, is not beyond the
ken of the “general joe” out there,
but that anyone can do things that
have real world applications (hence
the title of our series). That having
been said, making LEDs blink is
only the same kind of project for
the hardware world as the “Hello
World” program is in the
programming realm. You have to
take small steps before you move
to the big race. Believe me, we will
be doing some amazing things with
all those little parts, whatsits and
thingamabobs.

are using now will go unused after
a single project. For example, once
we have a grasp of some of the
Arduino basics (which WILL involve
learning a small amount of ‘C’ like
programming (sorry about that)),
we’ll be writing programs in
Python on the RPi (or your local
computer) to control the Arduino.
The sensors we have learned about
in our RPi experiments will be reused when we learn about the
Arduino, and many will be
incorporated into some larger
projects. Very shortly, we will be
using DC Motors, Solenoids and
Stepper Motors in some really
basic projects, but we’ll use them
in larger projects, including
building a Computer Controlled
This month, we will be using the (RPi) Laser Engraver using a Laser
DHT1 1 Basic Temperature/
Diode recovered from an old DVD
Humidity Sensor with our
Burner.
Raspberry Pi. Next month, we will
be doing the same sort of thing
Enough about the future. Let’s
using the Dallas DS1 8B20
start with this month's project.
temperature sensor, and if there is
time and/or space, we’ll also talk
The DHT1 1 is the least
about the 1 6x2 LCD display. In a
expensive sibling of a series of
few months, we’ll switch from the temperature and humidity sensor
Raspberry Pi to using the Arduino. sets. The DHT1 1 has a temperature
Don’t worry, none of the things we range from 0⁰ to 50⁰ C with ±2⁰ C
full circle magazine #1 09
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accuracy (32⁰ to 1 22⁰ F, ±3.6⁰F) and
a humidity range from 20-90%RH
±5%. You can see that it’s not the
most accurate sensor on the
market; there is a DHT22 that is
more accurate and has a wider
range (-40⁰ to 80⁰ C temp range)
but about twice as expensive.
It’s a bit of a funny looking
thing. A blue rectangular plastic
box with holes in it and something
shiny inside it. It might come just
as a single sensor with 4 pins, or
already on a mini-circuit board with
3 or 4 pins. Either way, they are
basically the same. For now, we’ll
use the discrete component (the
one without the circuit board) for
the sake of the discussion, and I’ll
address the differences as we go
along.
Whenever you want to work
with a new sensor, you should get
a spec sheet (data sheet). A simple
web search should turn up a
number of results. Try to get
something directly from the
manufacturer if at all possible. For
the DHT1 1 , a good place to get
one of the various data sheets
contents ^
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available is
http://www.micropik.com/PDF/dht
1 1 .pdf. While this isn’t directly
from the manufacturer, it is from a
company that sells it, and has
“translated” the manufacturer’s
data into a 9-page PDF file.
You might already be asking,
why do I need this? There’s a bunch
of information that, unless you
have a PhD in Physics or
something, you’ll never need. Well,
that is true, but there is a lot of
information that IS relevant and
can potentially keep you from
blowing up either the sensor, the
controller, or your work bench. In
this case, we find that the DC
operating voltage is between 3 to
5 volts and it pulls about 0.5mA
during “normal” conditions
(section 6). We also find that this is
a rather slow device and that we
should not try to pull data more
than once per second. Basically
we’ll keep it around once every
five seconds in our testing
program, which is way more than
we’ll need in reality. Another thing:
if the cable that sends the data
from the sensor to the
microcontroller (our RPi) is less
than 20 meters, we should have
about a 5K ohm resistor between
the data line and the local power

supply (at the sensor) as a pull-up.
One last thing (I’m going to stop
here, but there’s much more): Pin 1
is positive voltage, Pin 2 is the data
pin, and Pin 4 is the ground pin.
This gives us pretty much
everything we need to know to
safely connect this to our RPi.
Below is the wiring diagram for a

“raw” DHT1 1 sensor WITHOUT a
breakout board. If you have a
sensor with a breakout board, see
my discussion below the diagram.

a 5K resistor works pretty well. If,
however, you are going to use 5
VDC as shown in the diagram, use a
1 0K resistor.

Notice that I said earlier that a
5K resistor was needed as a pullup. If you are going to use 3.3 VDC
as a power source (RPi pin 1 ), then

You can see that it’s fairly
simple, just three wires and a
resistor. For our simple project,
don’t try to make the wiring the
entire 20 meters though.
If you have a DHT1 1 on a
breakout board, you will likely have
only 3 output pins on it. I have two
sensors from different vendors,
and (go figure) both have a
different pinout. One is laid out
[Data] [Positive Voltage] [Ground]
and is marked “S -”. The other is
[Ground] [Data] [Positive Voltage]
and is marked as such. Hopefully,
yours has some sort of pinout
definition printed on it. If not, you
can use a multimeter to trace the
ground pin and voltage pin directly
from the sensor to the breakout
pin. You can usually guess that if
there are three output pins on the
breakout board and you know
ground and positive voltage, then
the other SHOULD be the data pin.
Now our program code.
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For the sake of getting things
up and running quickly, we will be
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using some code provided by the
kind people at Adafruit.com – they
provide the library for working
with the DHT1 1 . (They found that
trying to run straight Python code
for the library causes some timing
issues, so the library is actually
written in ‘C’.) There are a number
of steps involved, so follow the
instructions carefully. I’ve
paraphrased them so if something
doesn’t work, you can also find the
instructions at the Adafruit
website at
https://learn.adafruit.com/dhthumidity-sensing-on-raspberry-piwith-gdocs-logging/softwareinstall-updated . Once everything
is done, you can run my modified
Python example presented at the
end of the instructions.

package is already installed.

In your "/home/pi" directory,
run the following commands:

Next, install the library by
running:

git clone
https://github.com/adafruit/A
dafruit_Python_DHT.git

sudo python setup.py install

cd Adafruit_Python_DHT
sudo apt-get update
sudo apt-get install buildessential python-dev pythonopenssl

Ignore any errors that state a

#!/usr/bin/python
# simpletest.py
#---------------------------------------------------# Original code information copyright below.
# Copyright (c) 2014 Adafruit Industries
# Author: Tony DiCola
# Permission is hereby granted, free of charge, to any person obtaining a copy
# of this software and associated documentation files (the "Software"), to deal
# in the Software without restriction, including without limitation the rights
# to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
# copies of the Software, and to permit persons to whom the Software is
# furnished to do so, subject to the following conditions:
# The above copyright notice and this permission notice shall be included in all
# copies or substantial portions of the Software.
# Code modifications by G.D. Walters for Full Circle Magazine
import Adafruit_DHT
from time import sleep
#---------------------------------------------------# Sensor should be set to Adafruit_DHT.DHT11,
# Adafruit_DHT.DHT22, or Adafruit_DHT.AM2302.
#sensor = Adafruit_DHT.DHT22
#---------------------------------------------------sensor = Adafruit_DHT.DHT11
#----------------------------------------------------

The two import statements and
the assignment of the variable
‘sensor’ to the class code.
pin = 4
sleep(3)

relating Celsius to “real”
temperatures, so I convert it so
that I can understand it. If you
want Celsius, just comment out the
conversion line.

Here we define that the sensor
is connected to GPIO pin 4 and
then we wait 3 seconds for things
to settle and be ready to work.

Now (next page, bottom right)
we check to see if we got realistic
values for both humidity and
temperature, then we display
them and sleep for 5 seconds.

We use a simple loop (next
page, top right) to grab the values
All of the above can basically be for humidity and temp over and
boiled down to three lines of code. over. I never got the knack of

I must admit, when I run the
program with one sensor, it gives
some rather wacky results for the
first two or three minutes, then

Once all that is done, you can
move on to our sample code.
Above is my modified sample
code “borrowed” from the Adafruit
sample code.
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#---------------------------------------------------# Here we loop over and over getting and displaying the
data.
# Use <Ctrl><C> to break out.
#---------------------------------------------------while 1:
# Try to grab a sensor reading. Use the read_retry
method which will retry up
# to 15 times to get a sensor reading (waiting 2
seconds between each retry).

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

humidity, temperature =
Adafruit_DHT.read_retry(sensor, pin)
# Comment out the next line to display Celsius
temperature = temperature * 9/5.0 + 32

settles down to values that I can
trust. The other sensor seems to
“lock in” faster, so I’m just writing
it off to something in the first
sensor.
Well, that’s it for this month.
Remember, we’ll be using the
Dallas temp sensor next time, so
be ready.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Have a good time and I’ll see
you next month.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.
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Li breO ffi ce Pt.60 - Q u i ck Ti ps

Written by Elmer Perry

his is part 60. The big six-zero.
Five years worth of articles
about my favorite office suite. Due
to demands at work and ambitions
to take my writing in other
directions, this is also my last
article in this series. It has been a
privilege to write for you each
month and teach you about the
many things you can do in
LibreOffice. Believe me when I say
I have learned a great deal by
writing for you.

icon sets used for the toolbars.
There are seven different icon sets
in the latest version 5: Breeze,
Galaxy, High Contrast, Oxygen, Sifr,
Tango, and Human. Human is the
default for Linux, and Tango is the
default for Windows. Personally, I
like Sifr. The flat black icons are
easy for me to sort through. The
colorful icons of the other sets are
distracting for me. You can set the
icon size and style at Tools >
Options > LibreOffice > View.

In the years writing about
LibreOffice, I have collected a lot
of helpful hints that were too
short to constitute an article of
their own. So, for this final hurrah, I
bring you 1 0 quick tips for using
LibreOffice.

2. KEYBOARD SHORTCUTS

1 . I CON SETS
You can customize LibreOffice
in ways that work best for you.
One of these customizations is the

what is available for LibreOffice in
general, or for the program you
are currently working in. It is worth
your time get to know the

shortcuts and start using them.
Don't try to learn them all at once.
Take a block of them and get
familiar with them. Once you have

Keyboard shortcuts are a great
time saver. Instead of taking your
hands off the keyboard to grab the
mouse and do something, your
hands can just stay at the keyboard
and get the same results. Like any
office suite, LibreOffice has a full
basket of shortcuts. You can get a
list of shortcuts at Tools >
Customize. Select the Keyboard
tab. Scroll through the list to see
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that group down, start in on the
next. In Tools > Customize, you can
create your own shortcuts. The
keys or key combinations in the list
that are not grayed out are the
ones that are available for
changing. I would steer clear of
those that already have
assignments, and look for ones
that don't. Select the category and
function from the two lists below
and click modify to assign that
function to the key or key
combination.

3. M OUSE ZOOM
After preaching about keeping
your hands off the mouse, my next
tip is about zooming using the
mouse. Most mice today have a
scroll wheel, and you can use the
scroll wheel to zoom in and out of
your document. LibreOffice allows
you to zoom from 20% (very small)
to 600% (huge). Press the CTRL
key while turning the scroll wheel
to zoom in and out. Zoom in (make
it bigger) by scrolling the wheel
forward (away from you), and
zoom out (make it smaller) by
scrolling the wheel back (toward
you). The amount of zoom is
controlled by your mouse settings.

4. CROP AN I MAGE
You can now crop an image
directly in LibreOffice. No more
opening GiMP or some other
image program just to crop an
image. To crop a selected image,
Format > Image > Crop. Or you can
click the icon on the Graphic
toolbar. The image is surrounded
by eight control handles. Crop the
image horizontally or vertically by
dragging the center handles in the
side and top/bottom edges.
Dragging the corner handles crops
both. Dragging while holding the
SHIFT key maintains the image’s
original aspect-ratio. After
cropping an image, you can resize
it and still maintain your crop. Crop
mode stops when you press ESC or
click anywhere outside the image. F2 key brings up the Formula
toolbar. The bar works in the same
5. Q UICK CALCULATIONS IN manner as the formula bar in Calc,
but you have a smaller set of
WRITER
functions you can use. Click on the
fx button for a menu of the
Sometimes while writing a
available functions. Once you
document, you need to insert the
finish, click the check button or
results of a calculation. You could
press the Enter key. The result of
go to your computer's calculator
the calculation will appear at the
program, but that means getting
last position of your cursor.
out of Writer to start another
program. Instead, use the Formula
6. PLACEHOLDERS
toolbar built into Writer. View >
Toolbars > Formula or pressing the
full circle magazine #1 09
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Placeholders are useful in
templates and Auto Text. They are
special fields that act as temporary
text until the actual text or object
is inserted. For example, if you
were creating a template for a
contract, you wouldn't know the
names of the parties involved in
the contact while you are creating
the template. You can insert
placeholder fields in the template
– to be filled in later when the
template is used to create a
document.
contents ^
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parts of the document that should
never change, you can protect
them from changes with a
password. Select the text you need
to protect, then Insert > Section.
Give the section a name. Check the
Protect and Password check boxes.
A password dialog will pop up.
Enter and confirm the password.
the
actual
information
for
the
Click OK. In the Section dialog,
To create a placeholder, CTRLdocument,
click
on
the
placeholder
click Insert.
F2 to open the Fields dialog. Click
and
start
typing
for
a
text
on the functions tab. Select
To remove the protection and
placeholder from the Type list, and placeholder. For the table, frame,
and
object
placeholders,
you
get
make changes, Format > Sections.
pick the placeholder type from the
the
appropriate
dialog.
For
the
Select the section you want to
Format list. You can pick from Text,
image
placeholder,
you
get
a
file
change. Uncheck the Protect check
Table, Frame, Image, and Object. In
dialog.
The
placeholder
is
replaced
box, and enter the password when
the Placeholder text box, enter the
with
text
you
type
or
object
you
prompted. You can now make
text you want to stand-in for the
set
with
the
dialog.
changes to the section.
placeholder. For example, with the
Text format selected, you could
7. PROTECTING SECTIONS IN 8. ENTIRE ROW/COLUMN
enter "your name" to create a
placeholder that reads <your
WRITER
REFERENCE
name>. The Reference is a help tag
that appears when you hover your
You can protect any section of a
When creating a formula in
mouse over the placeholder. Click writer document from changes.
Calc, you sometimes need to
Insert to enter the placeholder in
Some sections, like table of
reference an entire row or column,
your document.
contents, are protected by default. usually because the column or row
If you were creating a template for will grow and you have no way to
To replace a placeholder with
a legal document, and there were know where it will end. Before
version 5, you had to create a
reference like A1 :A1 048576 for
columns or A1 :AMJ1 for rows.
Now, you can use a short reference
to the column or row. For columns,
you can enter A:A to reference the
full circle magazine #1 09
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entire A column. For rows you can
enter 1 :1 to reference the entire
row 1 . You can even reference a
range of columns or rows (A:B,
1 :2).

9. AUTO FILTERS TOP 1 0
Calc allows you to easily show
the top 1 0 values in any column
through the AutoFilter function. To
activate the filter, Data > Filter >
AutoFilter. Once active, the filter
shows a down arrow in the first cell
of each column. Clicking on the
arrow opens a drop down menu.
One of the options is Top 1 0.
Select Top 1 0 and you will get the
top 1 0 records based on the values
in that column. You could use it to
determine your highest sales day,
or the day of the highest peak on a
stock. This tip works only for
columnar data. To clear the
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AutoFilter, select Data > Filter >
AutoFilter again.

convert this number to scientific
notation. Format > Cells. On the
Numbers tab select Scientific from
Category list box. Click OK. Our
1 0. SCIENTIFIC FORMAT AND the
number is transformed into Calc's
ENGINEER N OTATION
version of scientific notation,
1 .25E+1 3. 1 .25 is the significant
Scientific notation is used to
digits, E is the place holder for 1 0,
express very large or very small
and +1 3 represents the exponent
numbers. The basic idea is to take a of 1 0. If we want engineer
predetermined number of digits
notation, Format > Cells. Again,
and multiply them by powers of 1 0. with Scientific selected, check the
This allows scientists and
"Engineering notation" check box.
engineers to express these large
Our number in engineering
numbers without having to write
notation becomes 1 2.46E+1 2. Note
out all the digits. Engineer
that the exponent is now a
notation is a subset of scientific
multiple of 3.
notation where the powers of 1 0
are a multiple of 3.

O NE LAST THING

I'd like to share one last thing
with you that has been a big help
to me while writing 60 articles
about LibreOffice –
documentation. I have a few
helpful links to share with you.
Each one provides something
different.
The LibreOffice Community
Support Page:
Calc will allow you to express
both of these. Let's take the rather http://www.libreoffice.org/getlarge number 1 2455485785256. A help/community-support/
rather large number to type over
The Community Support Page
and over again. In Calc, we can
full circle magazine #1 09

has links to documentation, online
help, Ask LibreOffice, IRC, the wiki,
and mailing list. You will want to
check the document page often to
see what manuals have been
updated.
LibreOffice Documentation /
Publication Page:
https://wiki.documentfoundation.
org/Documentation/Publications

With that, we come to the
conclusion of my series on
LibreOffice. It has been a great joy,
and I wish many more successful
years of publication for Full Circle. I
will continue as a reader, and you
may still see an article from me
now and then, just not every
month.
I leave you with one final
thought, "Don't work so hardthat

If you can't wait for the official you don't take time to live, anddon't
release of a manual, this is the
live so hardthat you can't enjoy
page where you find the
work."
documentation team’s drafts. Keep
in mind that many of these
documents are drafts and may
contain mistakes and errors. When
I was writing about Base, this was
one of the only places to find
documentation at the time. Of
course, now there is an official
Base manual. Just my luck.
Document Foundation Blog:
https://blog.documentfoundation.
org/
The Document Foundation blog
is a great place to get news about
new releases, tips, events, and
more. They don't overwhelm you
with posts, but they do keep you
up to date.
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Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Written by Theo van Oosten

In the early days of computers, a
company called Digital Equipment
Corporation (DEC) created its 32bit VAX computer using openVMS
as its operating system. Because a
VAX/VMS computer is so reliable,
there are today - after more than
25 years - still a large number of
them in use. But, in the end, even
these reliable computers will have
to be replaced. As described in
part 1 , you could migrate from
VAX/VMS to Linux, as the way
Linux works is largely compatible
with VAX/VMS. If you use Pascal as
your programming language, you
will find that Lazarus/Free Pascal is
a good replacement. But there are
technical functions used in VMS
with no apparent replacement in
Linux. In this article I will describe
the terminal interface DCL and
ASTs.

DCL
When you log on to a Linux
system (or start the terminal), a
program is started to prompt you
for commands. This is called the
shell, and in my case this program
is Bash. When you log on to a VMS

M i g ra te From VAX/VM S To Li n u x Pt.5

system, the same happens. On
VMS, this program is called DCL
(Digital Command Language).
For the user, it looks like there
is no difference, but the way these
programs work is quite different.
As mentioned in part 3, there is
one big difference: DCL is a real
shell, it wraps around a process
and every time an executable
(“image” in VMS) is started, it runs
within this shell, within the same
memory, with the same logicals
and symbols (environment
variables), and with the same
process ID. Bash is called a shell,
but it is NOT! It is a CLI (Command
Line Interpreter). Every time an
executable is started in Linux, it's
started in a new subprocess with a
different PID.
Another difference is the use of
the “$”-character. In VMS, it has no
meaning and is frequently used in
names of logicals (like
SYS$SYSTEM), system calls (like
$QIOW) and internal DCL functions
(like F$ELEMENT). In Bash, it
denotes the translation of
variables, even if in between
full circle magazine #1 09

double quotes. This - and the fact
that Free Pascal has a similar
problem - is the reason why the
migration tool replaces the dollar
with an underscore.
DCL has a powerful set of builtin commands and functions. These
are so versatile that entire
programs have been written in DCL
functions. When you migrate a
VMS system to Linux, you will have
to include these “programs”. The
functions of bash to replace the
functions of DCL are so different in
syntax and working, that the
migration of DCL “programs” is a
lot of work and some will simply
fail to migrate as there might be
no substitution for one or more

DCL functions. An example - to
read a file is shown below.
In DCL every line must start
with a “$”, or it will not see it as a
command.
In Linux, the first parameter on
a command-line is denoted as 1 ,
while the same parameter in VMS
is denoted as P1 . The translation of
a variable in Linux is done by
prefixing with a $; in VMS by
enclosing in single quotes, hence
$1 in Linux is 'P1 ' in VMS. “echo”
writes a line to the terminal in
Linux; in VMS, “write sys$output” is
used. “sys$output” is a processlogical (for explanation of logicals
see part 3), so, by redefining

Bash:
while read a_line
do
echo $a_line
done < $1
DCL:
$ open/read 'P1' file_var
$loop:
$
read/end_of_file=done file_var a_line
$
write sys$output 'a_line'
$
goto loop
$done:
$ close file_var
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“sys$output”, you can influence
where the output is going.

variable inaccessible, like using a
CPU register for it. ASTs can be
My DCL program will accept the compared to signal catching in
“file_var” in the above example standard case-insensitive
Linux.
is also a logical. As a consequence, command:
this means that, if the file is not
The best equivalent of these
show
log
/group
*
.
closed, it will still be open if the
ASTs is the use of the method
same script (command file) is
“Synchronize” of the class
This way, every existing DCL
executed again in the same
“tthread”. To get the same
“program”
will
behave
the
same
session. That might be intentional
behavior as in VMS, the DCL
with
only
small
adaptations.
if two scripts have to be executed
process is used to process all input
consecutively, but it's usually a big
from the terminal and output to
problem when a script crashes and ASTS
the terminal. The DCL process
you start it again after fixing the
communicates through pipes with
problem. Then the file is still open
In VMS, all communication with a separate thread created at
and continues from the point
program start using the class
the terminal goes through the
where the script crashed, giving
“tthread”. When the user presses
driver “TTDRV”. When the user
unexpected results. In this case,
any of the special control
gives a special command using
after a crash, you have to close the control characters (mostly ^C, ^Y,
characters, this thread will call a
file manually by deleting the
^T and ^Z), the driver will issue an dedicated procedure - defined in
logical.
the class, but executed in the main
AST (Asynchronous System Trap).
thread - using “Synchronize”. On
Essentially, an AST is a system
I cannot imagine how a
^C, the process will terminate; on
callback routine. As it is unknown
migration tool would be able to
when this callback routine is called, ^Y, the main thread will be
create a working bash script from a you must take special precautions. suspended; on ^T, status
DCL script (in VMS this is called a
In VAX-pascal you signal this to the information will be sent to the
command-file, default file type is
terminal (if specified in the main
compiler through the attribute
.COM). So I started working on the “[ASYNCHRONOUS]” for the
thread), and on ^Z, a controlled
creation of a DCL clone. It will be
termination will take place. When
procedure that is called, and the
able to process DCL command-files attribute “[VOLATILE]” for any
the main thread is suspended after
while accepting commands from
variable accessed from within this ^Y, two things can happen:
the command-line using DCL
• If “continue” is typed in the DCL
procedure. The attribute
syntax. An example: To get the list “[VOLATILE]” prevents the
process, the main thread will be
and translation of the group
resumed.
compiler from doing any
logicals in Linux, I must execute
optimization that would make the • If a new command is given,
the case-sensitive command:
resulting in the start of another
full circle magazine #1 09
27
/VMS/show log -g “*” .

process, the suspended process
will be terminated.
To get this behavior, DCL must
be aware of the control characters
and act upon them.
Something like the attribute
“[VOLATILE]” is not necessary as I
have not seen Free Pascal doing
any optimization (unfortunately).
On activation of a QIO(W) (see
part 2) or timer, it is also possible
to specify an AST to be called on
termination. These are
implemented the same way, as
both work through the creation of
a new thread.

D ETACHED PROCESS:
If you start a detached process
(a process without a parent) in
VMS, it is started without DCL as a
shell. Some programs depend on
the existence of DCL - if they call
an internal function. To run such a
program, you must create a
command-file stating: “$run
program_name”, and start DCL as a
detached process with this
command file as input. This proves
that DCL itself is just a program
which is called “LOGINOUT.EXE” .
contents ^
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The most common use of this is
to execute a script (command-file)
as a detached program, for
example once a day to clean up,
back up, or trigger an event.

THE O FFICIAL FULL CIRCLE APP FOR U BUNTU TOUCH

B

rian Douglass has created a

fantastic app for Ubuntu Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

N EXT MONTH
In the next article I will go more
in depth about the network
database DBMS32 and its
(dis)advantages.

I NSTALL
Either search for 'full circle' in the
Ubuntu Touch store and click
install, or view the URL below on
your device and click install to be
taken to the store page.
https://uappexplorer.com/app/
fullcircle.bhdouglass

After keeping VAX/VMS systems
running for 30 years, Theo needed a
new challenge and started from
scratch with Linux to re-do every
mistake he made all over again. You
can email Theo at:
info@theovanoosten.nl
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Ba re Ba si cs O f Au d a ci ty

Written by Ronnie Tucker

S

ince starting the Full Circle
Weekly News
(http://fullcirclemagazine.org/pod
cast), I’ve had to learn the basics of
Audacity. Thankfully, since the
podcast is short and pretty simple
to put together, I only really need
to use the absolute bare basics of
Audacity.

I N THE B EGINNING
While Audacity might look

somewhat imposing. Don’t worry.
If your microphone is on and
We’ll be using only a handful of the ready to begin recording, you
items in its arsenal.
should see a horizontal green bar
flickering as the sound levels rise
The first thing you’ll want to do and fall.
(assuming you have a microphone
plugged in) is click the microphone NOTE: For the Full Circle Weekly
icon (below the menu) and select
News, I’m not going for high
‘Start Monitoring’.
quality output. Hence, you’ll see
me using mono audio and low
output settings. I’m trying to keep
the final file size to an absolute
minimum.
If you have a microphone
plugged in, but nothing showing in
the monitoring step, then you’ll
want to go to Edit > Preferences
(in the menu) and in that window,
select Devices. That’s where you
select your playback and recording
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devices.

TESTING TESTING
So, time to test things out. The
main feature at the top of the
Audacity window is the all-toofamiliar controls such as pause,
play, stop, etc.
When you’re ready, click
the record button
(shown left, the one with
the big red dot on it), and pause
for a second or two before
speaking. Why? I’ll show you
shortly.
Ok, now do your
speaking. Press the stop
button (shown left,
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square icon) to, well, stop
recording.

You should now see a waveform
of your speech (previous page,
bottom right).
Pressing the play button
(shown left, green
triangle) will play back
the speech you recorded.
What’s that? You had to turn
the speakers up to hear it? OK,
let’s clean this up a bit and
increase the volume on it.

This will select the entire
waveform for you. Nifty!
Now, in the menu, choose
Effect > Noise Reduction. In the
popup that appears, click the ‘Get
Noise Profile’ button.

N OISE REDUCTION
First, click the
‘Selection Tool’
(shown left, a
vertical bar)
from beside the
record button. To zoom in/out of
your waveform you can click the
magnifying glass icons. What we
The window will close.
want to do is select the empty
portion of the waveform. That first
What we’ve done here is tell
second, or two. Click and drag at
Audacity that the selected area is
the start of the waveform to just
background noise.
where the waveform becomes
taller. Like I’ve done in the
Now click the area to the left of
screenshot.
the waveform – just above the
small ‘Mute’ and ‘Solo’ buttons.
full circle magazine #1 09

In the menu, again, click Effect
> Noise Reduction, but this time
just click OK. The rest of the
settings are set for us from the last
step.

Effect > Amplify. This effect will
amplify the waveform to make it
louder. Where it says ‘Allow
clipping’ should be unchecked. If
this is checked then it will mean
the amplification could be
excessive and it might distort your
audio – making it sound bad. The
amplification setting that Audacity
has chosen for this waveform is
1 0.36. I’ll go with that (by clicking
OK).

It’ll probably be small, but you’ll
see a change in your waveform.
Here’s mine before and after:

It’s not much, but it’s cleaned
up the waveform.

AMPLIFICATION
Now, in the menu, choose

30

You can see that one of the
spikes is just touching the bottom
edge of the preview window.
That’s clipping. If I’d checked the
box I could up the dB setting, but it
would take the waveform out of
the range and possibly cause
distortion.
I could just as easily click Edit >
Undo, select my waveform, do
Effects > Amplify again and up the
contents ^
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dB to try it out. Audacity is pretty
good with its undo feature.

1 28Kbps MP3 file.

S AVING PROJECT

OK. I have my waveform
cleaned, and amplified. Now I can
Select the entire waveform
select the blank space (as we did
again and, in the menu, do Edit >
before) and press the delete key to Duplicate. If you play the audio
remove it. Same at the trailing end you’ll get a slightly louder sound.
of the waveform.
But click the
‘Time Shift Tool’
(shown left) and
drag the bottom
waveform to the
right slightly. Now click Play.
Spooky!

Now it’s time to save your
masterpiece.

S AVING AUDIO
In the menu, click File > Export
Audio. In this window you choose
the file name, file format, and
some quality settings. Like I
mentioned earlier, with the
podcast I go for low quality and a
small file size, so I usually go with a

can reload your layout and
continue editing later.

M ORE?
Audacity can do a million other
things, but I never use them. The
things I’ve shown you above are
enough for me to create a quick
podcast.
If you’d like to see more about
Audacity do let me know. For
another part, I could show you how
to use the Envelope Tool to create
nicely controlled fade in/out
effects that I use in the podcast

intro (shown below).
If you’ve any Audacity tricks
you’d like to share, feel free to
email them to me, Ronnie, at:
ronnie@fullcirclemagazine.org

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

But with the move tool you can
also drag the waveform up. You
can close the now empty track by
clicking the X at the top left of the
track. Now you’ll get the same
thing twice.
Pretty useless, but this shows
you how to drag and drop
waveforms within Audacity.
The whole point of this exercise
is to show that there is a File >
Save Project option too. That
doesn’t save an audio file. That
saves an AUP file which is your
Audacity project. This means you
full circle magazine #1 09
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Written by Mark Crutch

ast time, I introduced the Filter
Editor dialog and
demonstrated how to create a
simple filter chain, resulting in a
drop shadow effect. The chain
consisted of three filter primitives:
Gaussian Blur, Offset and Merge. I
also used the Source Alpha and
Source Graphic inputs. Recall that
each primitive in the chain has one
or more inputs, denoted by
triangles, and a single output
represented by the bottom of the
primitive. The output from the
chain as a whole is always the
output from the last primitive.
Therefore, in the Inkscape UI, our
drop shadow chain looks like that
shown below left
With a simple chain this is fairly

understandable but, as the
complexity of your filters grows, a
simple one-dimensional list
becomes an unwieldy tool for
looking at the complex
arrangement of primitives that
evolves. Mathematically speaking,
filters are a “directed graph”,
consisting of a series of nodes (the
primitives) and uni-directional lines
connecting them. Such graphs are
usually drawn in two dimensions,
and you may find it easier to try to
imagine your chains in that form.
For example, our simple drop
shadow could be represented like
that shown below right.

output. The gray box just shows
the intermediate result that you
would see if you could peek into
the filter chain at that point.
Hopefully you can see how this
layout relates to the Inkscape UI,
and I'll use this approach again to
describe more complex filters as
the series goes on.

your shadow to be more
translucent – gray rather than
black – or you want it to have a
different color entirely? There is a
filter primitive that lets us
manipulate the color of the image
in the chain, but unfortunately it's
another case of a confusing UI that
could have been made a lot more
obvious.

One problem with our drop
shadow is that it's based on the
Start by adding the Color Matrix
Source Alpha of the original object, primitive to your filter. It will
which is essentially a black
appear at the bottom of the chain,
silhouette. But what if you want
but you can drag it to another

Here I've used blue boxes for
the primitives, green for the image
sources, and teal for the final

full circle magazine #1 09
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Above is that same matrix,
presented with some headings to
help clarify things:
location. We'll start by changing
the opacity of the shadow, so it
either needs to go after the
Gaussian Blur step (to change the
opacity of the already blurred
image), or right at the top of the
chain (to change the opacity
before the blur is applied). Either
approach will give roughly the
same result, so I've chosen to put it
at the top of the list. You then
need to modify the connections so
that the Color Matrix gets its input
from the Source Alpha column, and
the Gaussian Blur gets its input
from the Color Matrix primitive.

With the Color Matrix primitive
selected, take a look at the
parameters at the bottom of the
dialog. First there is a Type pop-up
which lets you select between four
different varieties of color
manipulation. Three of them have
simple, easy-to-use interfaces… so
of course we need the other one!
Select the Matrix option (this is
also the default when you first add
the primitive), and you'll be
presented with a grid of numbers
with little extra explanation (there
is a lengthy tooltip, but I'm not
sure it helps very much).

full circle magazine #1 09

ROUT = (RIN × 1 .00) + (GIN ×
0.00) + (BIN × 0.00) + (AIN × 0.00) +
(255 × 0.00)

Remember that filters are a way
to manipulate the bitmap version
of your vector image, just at the
point it's converted to pixels. This
matrix essentially holds some rules
about how each individual pixel in
your input image should be
modified in order to produce the
corresponding pixel in your output
image.

The bold numbers in the
formula are taken from the first
row of figures in the matrix. Clearly
only the first value has an effect in
this case, as all the others are zero,
so ROUT is simply the same as RIN
× 1 .00. In other words, with these
figures the red component is
passed through untouched, with a
value of 1 50. If you repeat the
process for each of the remaining
Let's take the top row as an
three lines, you'll see that the
example. Suppose the first pixel in default color matrix simply passes
our image has an RGB value of
the input color through to the
(1 50, 1 28, 255) and it's completely output without modifying it. It's an
opaque (an Alpha value of 255). To “identity” matrix, in mathematical
calculate the color of the output
terms. Because the same matrix is
pixel we have to calculate its R, G, used for every pixel in the input
B and A values separately – the top image, the result is that this filter
row, therefore, is only concerned
primitive will just copy the input
with the Red component of the
image directly to the output
pixel. The formula for calculating
without changing it at all.
the Red output pixel value is:
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To make the drop-shadow more
translucent, we need to modify the
output Alpha value. On the bottom
row of the matrix, click on the 1 .00
field and change it to 0.50 then
press the Return or Enter key.
Immediately you'll see the drop
shadow change. You can choose
any value you wish (between 0.00
and 1 .00) in order to create a
lighter or darker shadow.
What about changing the color
of the shadow? There are a few
ways to go about this, but we'll
start by using the fourth column in
the Color Matrix – the one labelled
as “Fixed Offset” in my diagram.
Consider that the black pixels in
the Source Alpha image have an
RGBA value of (0, 0, 0, 1 ) – with all
those zeros it's clear that no
amount of multiplication will
change the output of the red,
green and blue components. But
the fourth column lets us add (or
subtract) a fixed value. If you
change the fourth column on the
third row to 0.80, the formula for
the blue component of the output
pixels becomes:
BOUT = (RIN × 0.00) + (GIN ×
0.00) + (BIN × 1 .00) + (AIN × 0.00) +
(255 × 0.80)

The multiplied R, G and B values
all come to 0, but then we add 255
× 0.8 onto the result, giving us a
final blue component of 204. Our
RGBA output value therefore
becomes (0, 0, 204, 1 ), giving us a
blue drop shadow. Try changing
the values of the fixed offset for R
and G as well and you'll quickly see
that we can use this technique to
produce any color of shadow we
want, all from our black silhouette.

How about using the Color
Matrix filter to go in the opposite
direction – to generate a black
shadow from a colored one? No
problem, but first you'll need a
colored image to work with. The
easiest option is to move the input
connection from Source Alpha to
Source Graphic. You should also
change your Color Matrix values
back to the identity matrix to give
you a known state to start from.
full circle magazine #1 09

With that done, your drop shadow
should now be the same color as
your original object (red, in my
case).

To convert our color to black,
we have to set each component to
zero. There are a couple of ways to
do this:
• Put -1 .00 into the Fixed Offset
field for the R, G and B output
values. No matter what the input
values are, this has the effect of
subtracting 255 from the output.
This has the effect of setting each
output to zero, because it's not
possible for a color component to
go any lower than that.
• Change the 1 .00 values in the first
three rows to 0.00 instead.
Regardless of the input value,
multiplying it by zero will give a
zero output.

give me a black drop shadow once
more:

Of course this is a terribly
inefficient way to create a
silhouette compared with just
linking to the Background Alpha
source, but it helps to demonstrate
how output values are calculated
from input values. So far, however,
we've just looked at simple
mappings, where red remains red
and blue remains blue, but this
filter primitive also allows you to
map one input component to a
completely different output.
Consider a matrix like this:

I took the second approach, to
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It's similar to the identity
matrix, except that the R, G and B
columns are shifted by one place.
The result is that the red
component of the output pixel is
taken from the value of the green
component of the input, whilst the
green output comes from the blue
input and the blue output is taken
from the red input. Let's see the
result on a multi-colored source
image:

esoteric filters. Most of the time,
you are only changing a single
however, you don't need that
value in the bottom row.
degree of flexibility, so the Type
pop-up provides three other
options to avoid you having to
wrestle with the full matrix:
• Saturate : Provides a slider to let
you change the saturation of your
image. In other words, remove
color from it, ultimately producing
a grayscale result at the most
extreme.
• Hue Rotate : Shift the color of
your object by a fixed amount.
• Luminance to Alpha : Set the
output alpha based on the RGB
Although I've shown only
input values. In theory this makes
relatively simple examples here,
dark areas more transparent and
it's possible to create complex
mappings between color channels. light areas more opaque, but RGB
Notice that this moves away
If you really want your red output doesn't map neatly to the human
from having a simple fixed color
to consist of 90% of the red input, perception of brightness, so this
for the shadow, and instead
less 1 0% of the green, less 35% of really works effectively only on
produces different colors based on the blue, plus a fixed offset of 64, grayscale input images. This can be
the corresponding pixel in the
used to punch holes in your filter
you just have to put values of 0.9,
input image. If you include the
output, based on the images
-0.1 , -0.35 and 0.25 into the top
output Alpha channel, things can
produced in other parts of the
row. Of course, predicting the
get even weirder. Here's our multi- output from complex combinations chain.
colored text with the RGB values
like this becomes rather difficult,
zeroed to give us a black drop
Notable by its absence is a
so for normal use I recommend
shadow again, except that the
shorthand option for adjusting the
sticking with simpler, easy to
fourth row has been changed so
opacity – where we came in at the
understand mappings.
Mark uses Inkscape to create three
that the Alpha channel is taken
start of this article. Unfortunately,
webcomics, 'The Greys', 'Monsters,
from the Red input component.
This ability to flexibly map color if you want to make your drop
Inked' and 'Elvie', which can all be
found at
Notice that colors with a high red
shadow a little more transparent,
components to each other, or to
http://www.peppertop.com/
value have dense, solid shadows,
you have no choice but to deal with
and from the Alpha value, can be
whilst those with no red in them
the full matrix approach, even if
useful on some complex and
full circle magazine #1 09
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(such as the green S and blue O in
“Shadow”) have no shadows at all.
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AR D U I N O

A rd u b o y

Written by Ronnie Tucker

palm of your hand.

The Arduboy comes with one
game pre-installed (a Tetris clone)
Internally it uses an AT
but there are many online games
MEGA32U4 with an SSD 1 306 OLED that can be uploaded to the unit.
screen. Here are some other specs:
• Total Flash Memory: 32kb
Uploading games is something I
• RAM: 2.5kb
haven’t tried yet, but I’ll try and
• EEPROM: 1 kb
cover that next month as I think it
• Frequency: 1 6mhz
• Monochrome Display: OLED
• Horizontal Pixels: 1 28
• Vertical Pixels: 64
• Lithium Polymer Battery: 1 80mAh
• Piezo Speaker: 1

is done by uploading the actual
code, ala Arduino IDE, but I’ll
double check on that first.
https://www.arduboy.com/
Price: $39

A

while ago I backed a
Kickstarter project called
Arduboy. Well, many months later,
it has come to fruition and I finally
have one of these incredibly small
units.
Think of a marriage between a
Nintendo Gameboy and an
Arduino. That offspring would be
the Arduboy. Measuring just 53mm
x 85mm x 5mm, and weighing just
1 4 grams, it easily fits into the
full circle magazine #1 09
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Am a zon Ta p

Written by S. J. Webb

ver the course of the last
year, I wrote exclusively
about the Chrome OS.
Consequently I became interested
in the cloud. Future articles will be
on cloud focused products,
Chrome OS, and random thoughts
of a Linux lunatic. This month I will
review one cloud based item.

arrived in a simple black box with
simple instructions. The Tap needs
to be fully charged. I then
downloaded the Alexa App to my
iPhone. Using an iPhone, I
connected to the Tap. After that
successful connection, I tied the
Tap into my Wifi. The Tap is tied to
my Amazon Prime account.

One item that touches the
cloud is the Amazon Tap. Some
reviewers consider it to be the real
life version of a personal assistant.
This is the vehicle for Amazon’s
virtual assistant named Alexa.
Alexa is Amazon’s answer to
Cortana and Siri. Alexa can be
found in an app—similar to
Amazon Echo and Amazon Echo
Dot. The Tap is a middle-of-road
option. The Echo and Echo Dot are
always active to answer your
commands or questions. The Tap is
not and requires a touch button to
use it (see photos). Therefore the
Tap has a longer battery life, since
it is not always active.

I can ask basic questions, and
listen to books, or music. The
sound quality from the Tap is fine
for the average owner. There is a
learning curve to Alexa. You must
learn how to give commands
correctly to maximize Alexa’s
usefulness. Simply stating
“Ramones, I wanna be Sedated,”
does not work. You need to say “I
want to hear I wanna be Sedated
by the Ramones.” Alexa will then
query Amazon and start playing
the song.

I purchased the Tap directly
from Amazon. The item was
backordered for three weeks. It

learning AI protocol developed by
Amazon. To maximize Alexa, I have
to interact with the iPhone App.
There are numerous cloud
products to simplify our lives,
which are unnecessary—Rocket
Book One is such an example. It is a
well made notebook, that is quite
sturdy. However it is a notebook
that uses QR codes, an app, and
the camera on your smartphone.
From these three elements, you
can write your notes, take a
picture, and it will label the page
via QR code to reside on the cloud.
Thus, I can have instant access to
my notes on my iPhone. While it
sounds magical, it is something I
can already do with my iCloud
account or Google Photos.

Alexa has a learning AI. She
eventually recognizes your voice
and preferences. Additionally, the
Alexa App on my iPhone checks if
my requests and fulfillment are
done correctly. Alexa lists these as
cards. These cards are a part of the
full circle magazine #1 09

SJ Webb is a Linux Hobbyist and

Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
full circle magazine #1 09

When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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N etbook Reviva l

Written by Alan Ward

ith 1 6.04 Xenial Xerus, all
versions of our *Ubuntu
distributions are Long-Term
Support (LTS). So, now seems a
good time to cast a glance at what
hardware is still capable of running
them. People with aging
computers may be on the fence on
whether to stay with 1 4.04 -- still
to be supported up until April of
201 9 -- or to switch to a newer
version. Better support for newer
pieces of hardware (graphics cards,
Bluetooth and whatnot) may not
be of interest for users of older
machines, but keeping an old but
still working machine in business
may well be.
The first piece of advice will
naturally be: “If it ain’t broke, don’t
fix it”, meaning that if you are
happy with your computer the way
it is, there is no immediate hurry to
change versions. Just keep it up to
date, and you will mostly be fine.
With that out of the way, what
about those who like to have the
newest and greatest, while still
running what would in some circles
be considered “legacy” computers?

Netbooks are a breed that can still
be of use thanks to their low
weight and general ease of
transport. Unfortunately, not many
are offered new these days, being
replaced by tablets and
Chromebooks. I have nothing
against such, but there are
situations in which a good old VGA
output or an Ethernet port can be
of use… So putting an old netbook
back into use as a nomad's
computer can make sense in more
ways than one (money being,
naturally, a consideration as well).
However, not all netbooks are
still quite up to the task. For
example, the Asus eeePC can no
longer handle a standard Ubuntu
installation inside its puny 4 GByte
internal drive. Older netbooks
using the PC2700 memory
modules may also be out of luck,
since it may be difficult to find a
combination of memory modules
capable of getting a reasonable
total amount of RAM. Most
modules were, like these, of only
256 MByte capacity, and there
used to be a maximum of two
memory slots available in most
full circle magazine #1 09
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laptops.

For a reasonable minimum
hardware starting point, perhaps
an Intel Core Duo or Atom dualcore CPU with 1 GByte of RAM can
be considered a bare minimum,
below which the resulting system
may very well be convinced to run,
but no longer give a good user
experience when actually working
with it. To set an example, I will be
using an Acer Aspire One (D250)
from back in 2009. This particular
computer has an Atom N2600 1 .6
GHz CPU, 1 GByte of DDR3 RAM, a
1 0" screen with 1 024x600
resolution, and supports internal
2.5” hard drives though a SATA-I
compatible (1 .5 Gb/s) connection.
It also has a WiFi card, but no CD or
DVD. It originally came with some
version of Windows 7 (Windows
Home, perhaps) though the sticker
on the bottom is completely faded
and I cannot be bothered to
remember. In any case, it has run
several versions of Ubuntu over
the years, from 1 0.04 on up to the
latest Linux Mint 1 7.3 MATE based
on Ubuntu 1 4.04. But can it still
perform under 1 6.04?
Since 1 6.04 had not yet been
officially released at the time of
writing, I used the Beta 2 releases

for Ubuntu and Ubuntu-MATE for
this test. Naturally, the i386 (32bit) architecture versions were
chosen, as indeed they must be on
most netbooks. 64-bit CPUs came
late to these laptops compared to
desktops or high-end laptops, and
little can be found before AMD
came into the market in later
Aspire Ones, with an 1 1 " screen.
Actually, the Acer does work
quite well under Ubuntu 1 6.04 yes, even under Ubuntu itself with
the Unity desktop manager. I am
typing this right now on Google
Drive running the Live CD and
Firefox. There is a noticeable lag
between hitting the keys and

getting text to actually appear on
screen -- especially when one of
the images occupies some real
estate on-screen -- but actual work
can happen. It is in fact less
annoying than a second computer
on my desk at this particular time,
which has Windows 8.1 getting
purged of the various pieces of
useless software the manufacturer
stuck on it from new, and which
now has the hard drive rumbling
along, pegged at 1 00% usage.
There are no hard drive noises
from the Acer, which is running
along nicely just from RAM.

The main one on this computer
was the insistence of the system to
continuously go to sleep - every 1 0
seconds or so. This seems to be a
bug that came with systemd. Not
that I wish to bash upon systemd,
but several bugs have appeared
because of it over the months. In
this case, a solution is easy to
implement by opening a terminal,
getting root access and editing file
/etc/systemd/logind.conf:
ubuntu@ubuntu:~$ sudo bash
root@ubuntu:~# editor
/etc/systemd/logind.conf

Two lines need to be added,
There have been some
annoyances along the way, though. that basically tell the power
management system not to sleep
if the lid closed sensor is triggered.
There is no need to take any
account of this sensor, basically
because this computer does not
have one! Anyhow, this is clearly an
issue with this particular model,
and should not happen with other
makes or models. The two lines
are:
HandleSuspendKey=ignore
HandleLidSwitch=ignore

Once done, we will need to
restart the corresponding service.
full circle magazine #1 09
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On my computer, for some reason I
also needed to restart the network
management service. Perhaps the
power management system also
shuts down the WiFi card, though
this is just me speculating:
root@ubuntu:~# service
systemd-logind restart
root@ubuntu:~# service
network-manager restart

swapping occurs when our RAM is
nearly full.

processor on these CPUs. The GPU
in the Atom runs either at 200 or at
400 MHz - i.e. quite slowly. Its lack
of processing power when
calculating overlays and other
graphic effects must be completed
by the main CPU itself, which does
tend to run hot as a consequence.

On the other hand, the
processor is getting hit rather
hard. The bottom of the netbook
got quite toasty, as both cores
were used consistently. Part of the
fault does not in fact lie with the
system itself or the programs, but
It may be noted that, as a
rather with the integrated graphics result, battery life in these

conditions may be greatly reduced.
The computer is also running on a
battery that was manufactured
back in 2009, so with less capacity
than modern batteries and also
not at its best due to much use
during the intervening years.
Logically, one way to use less
resources is to adopt a less powerhungry desktop manager. One of

root@ubuntu:~# exit
ubuntu@ubuntu:~$ nm-applet &

Once this is done, everything
just worked - for me. For others, on
different hardware, WiFi drivers
may become an issue that needs to
be handled in the usual way.
Memory usage is about 780
MBytes, including the basic
system, the Unity desktop
manager, Firefox, and the rather
memory-hungry Google Drive web
editor, which is to be expected
since it makes an intensive use of
JavaScript. It can be noted I had
virtual memory turned on for this
computer. The LiveCD has
detected the swap partition from
an existing installation on the hard
drive, and is using it for some extra
space. This does seem to speed
things up a little since less pagefull circle magazine #1 09
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the leaner versions of Ubuntu
comes with the MATE desktop, so
that was what I decided to install
on this machine. The installation
itself worked flawlessly, even
though I made things slightly more
interesting with a combination of
ext4 (/boot) and btrfs (/, /home)
filesystems.

expected would be through a
processor swap. But it is indeed
unfortunate that netbooks have
CPUs soldered onto the main
board, that simply cannot be
changed - unlike a desktop
computer. On the other hand, both
memory and the hard drive can
usually be easily exchanged.

necessary information, and
memory module form factors also
tend to be different, helping figure
out which modules may or may not
be installed in which computers.

of disk space, whereas Linux
variants may have ample disk
space with just 5 GBytes, or even
less. Ubuntu just uses the disk
rather less than other operating
systems, reading in and writing out
As for hard drives, there is a
less data at each system boot. So
tendency nowadays to swap
the gain obtained through
laptops’ original “spinning platter” switching to a speedier SSD, while
drives for Solid-State (SSD) drives - certainly noticeable, is not as
As expected, memory usage is
On the RAM side of things,
and, with offerings such as this 1 20 extreme as that obtained under
lower with this desktop manager.
most netbooks came with a single GByte model for less than 50 Euro, those other, heavier, operating
With the same Firefox + Google
module of PC-5300 DDR2 RAM.
this type of upgrade certainly
systems.
Drive workload, usage went down Many modules were of only 1
makes sense for modern machines.
a good 1 00 MBytes, which may not GByte capacity, though others held
As for netbooks, unfortunately
seem much but can make the
2 GBytes. Since many netbooks
Now, we may consider the fact their main boards were usually
difference between the system
contained only a single memory
that operating systems such as
designed to give adequate support
needing to swap, or not. Swapping slot, upgrading from 1 to 2 GBytes Windows or OS-X usually weigh in for platter-type hard drives, which
out pages of memory to the hard
may mean somehow sourcing a 2
at a minimum of about 20 GBytes
means typical data transfer speeds
drive is a slow process.
GByte memory module - which may
not be easy. Needless to say, they
Processor usage was also down are generally considered obsolete
by quite a bit, leading to a slightly and not usually carried anymore,
cooler underside for the computer, and if you do find them it may be
and less fan noise for the user.
at stupid prices. Cannibalizing
Even using an office application
another, non-functional, netbook
such as LibreOffice Writer works
may be of use here.
well on this one - better, in fact,
than Google Drive since the RAM
However, care should be taken
requirements are slightly lower.
to use only the appropriate type of
memory. SO-DIMM PC-5300 DDR2
Once we have established that RAM running at 333 MHz may be
Ubuntu 1 6.04 may be used on this the most common type, but it is by
class of hardware, some tuning
no means the only one found out
may be undertaken. Perhaps the
in the wild. The label on the
area in which most gains could be module itself usually conveys the
full circle magazine #1 09
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in the 80 to 1 00 MByte/s range. A
SATA-I connection is certainly up to
that, topping out at 1 50 MByte/s.
However, modern SSD drives can
usually spit out data at 250 to 300
MBytes/s, requiring the faster
SATA-II (300 MBytes/s) or SATA-III
(600 MBytes/s) connections. If the
computer’s main board is only
capable of SATA-I, at best the hard
drive will be limited to just 1 50
MBytes/s - and at worst will simply
not be recognized by the
computer, which is what happened
to my Aspire. So a best-case
speedup of only about 2x may be
expected by changing the hard
drive, much less than that
experienced on higher-grade
machines with SATA-II or -III
interfaces that can go up by 4x or
5x.

age by now, and so may in all
probability fail on us at some
point. Another is that SSDs have no
moving parts, may survive falls and
other accidents even while being
used, and so are better suited to
computers that get hauled (and
banged) about quite a lot during
the working day. However, care
must be taken either to source an
SSD that also accepts SATA-I
connections, or to ensure that the
netbook's chipset handles at least
SATA-II.

Ubuntu 1 6.04 has been hailed
as the version of Ubuntu that will
achieve convergence across many
different platforms. While this is
certainly true, perhaps we users
should also be aware that the need
to cater for hardware with varying
levels of performance has no
But this should not dissuade us doubt brought about a new
awareness within the developer
from swapping the hard drive. As
stated above, prices on SSDs have community that certain previous
versions of Unity were simply too
really gone down, to less than 1
slow. There has been a salutary
Euro per Gigabyte especially for
reaction from developers. Things
the lower capacities. Even if our
have certainly been turned around,
netbook cannot handle the extra
speed and will be limited mostly by and this newest version (for now)
has regained some of the terrain
the slow processor, there will be
some advantages to having a new lost. I have no precise numbers in
drive. One is that the original hard front of me, but there is a distinct
drive that came with the netbook feeling that Ubuntu 1 6.04 is no
heavier on a machine than 1 4.04,
may be getting on quite a bit in
full circle magazine #1 09

and may be distinctly lighter when
using a lightweight desktop
manager such as MATE. Time will
tell, but I get the feeling that 1 6.04
may be one of the keepers.

THE FULL CIRCLE
WEEKLY N EWS

A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast
Alan holds a PhD in Information and
the Knowledge Society. He teaches
computer science at Escola
Andorrana de Batxillerat (highschool). He has previously given
GNU/Linux courses at the University
of Andorra and taught GNU/Linux
syadmin at the OU of Catalunya.
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Written by Charles McColm

ast month, our refurbishing
not-for-profit was approached
by a small not-for-profit
community looking for a donation
of used computers. The
organization had recently been
given some space in which to meet
(they’d been meeting in member’s
houses before this), and now
needed a few computers so
members could learn basic
computer skills. In my original
discussion with the executive, they
mentioned that the organization
had no funding for computers.
After a short discussion about
licensing and what the

Sm a ll U bu n tu M ATE LTSP I n sta lla ti on

organization was looking for, it
dawned on me that a Linux
Terminal Server Project
(http://ltsp.org/) might work for
them. I pulled out a thin client
we’d just received as a donation
and asked the executive if they
were interested in a client/server
setup. The executive seemed
excited at the prospect of getting
thin clients (having worked with
them before), but their timeline
was very short—less than 1 week.
Having never even set up a PXE
network boot server before, I
needed clear instructions: I found
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them at Bobby Allen’s Blog:
http://blog.bobbyallen.me/201 5/0
7/1 9/setup-a-ubuntu-1 4-04-ltsmate-terminal-server-with-ltsp/
For the server, I used a retired
desktop machine that our project
once used as a SAMBA file server.
The server had an Intel Core 2
Quad Q9400 (2666MHz processor)
in it, and 2GB of DDR2 667MHz
RAM. The drives we’d pulled and
wiped a long time ago, so I
installed a pair of matched 80GB
hard drives. Initially I created a
hardware-based RAID mirror (using
the motherboard RAID controller),
but I reconsidered the idea and
decided just to ditch the hardware
RAID and clone the installation
drive once I was happy with the
LTSP server setup. (In my
experience people sometimes
have “friends” with good
intentions who install less than
legitimate software on their
computer, cloning the drive would
at least give me some sort of
backup should this happen). I also
pulled the 2 x 1 GB of RAM and
inserted a matched pair of 2GB
sticks for 4GB 800MHz DDR2 RAM.
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Initially I understood that the
organization had an existing
Internet connection so I figured
the best thing to do was to set up
the server for DHCP and when I
got to the facility get their system
administrator to set a DHCP
reservation for the server, then
update the SSH keys and the image
that gets built.
There are a few ways to build
LTSP images, but building an image
off an existing installation seemed
like the simplest way to go and
Bobby’s instructions for updating
an image are really clear. Some
LTSP installations need 2 network
interface cards, but Bobby’s
method uses only one card and the
LTSP server acts as a proxy for the
clients. The server acting like a
proxy tripped me up when I first
got LTSP running because I
couldn’t understand why the
clients showed the server address
when I ran the command:
/sbin/ifconfig. After rebooting the
client, I noticed a unique (nonserver) IP address in the bottom
right of the login screen. It’s only
on logging in that the client uses
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the server’s IP as a proxy.
Because all the clients would
likely be 32-bit, and it wasn’t likely
that the organization would have
more than 3 or 4 computers, I
chose to install the 32-bit version
of Ubuntu MATE 1 4.04 on the
server.
As with any desktop or server
installation, it’s always a good idea
to update before installing any
new software:

broken in Ubuntu 1 4.04. Ubuntu
actually has a few tftp server
packages in the repositories, but
the one that he used, and that kept
coming up on all the LTSP-related
sites, was tftpd-hpa. Lastly, the
ltsp-server package is needed so
the LTSP client environment can be
built.

Pentium 4 based desktops with no
hard drives instead, but more on
this later) were 32-bit, and because
I’d installed a 32-bit version of
Ubuntu MATE on the server. Build
a 32-bit client using the following
command:
sudo ltsp-build-client --arch
i386

sudo apt-get install dnsmasq
tftpd-hpa ltsp-server

If you’re building for 64-bit
clients, just remove the --arch i386.
The next step is to build the
You’ll also need to replace the i386
LTSP image that will be served to
in several other places with amd64
the clients. Because the build
including the next step, enabling
sudo apt-get update
process has to download packages, the DHCP proxy support. For 32-bit
this step can take quite a bit of
images, run:
Some LTSP server setups use
time,
especially
on
a
slow
Internet
the paradigm of letting the server
sudo sed -i 's/ipappend
connection, so be patient. In my
act as a DHCP server for clients.
2/ipappend 3/g'
case, I was building a 32-bit version /var/lib/tftpboot/ltsp/i386/p
Because I didn’t know the
of Ubuntu MATE because the thin xelinux.cfg/default
organization’s network setup, it
seemed a better idea to allow their clients I picked (I actually ended up
Again, if you’re building for 64router to do DHCP, but the server using some old HP DC71 00
would act as a proxy for the router
- dnsmasq provides this
functionality. Dnsmasq can be set
up as a DHCP server, but, in this
case, I used it to forward DNS to
the clients.
The LTSP image had to be
deployed to the clients some way.
Bobby mentions in his blog that
dnsmasq can also act as a tftp
server, but that the functionality is
full circle magazine #1 09
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bit, replace the tftpboot/ltsp/i386
with tftpboot/ltsp/amd64. Bobby
also mentions that if you update
your image, something I did
several times, you’ll have to rerun
the above command. (Once I
tested my image on the clients, I
decided to add several graphics
and educational software
packages to the server, rebuilding
built them into the client image)
DNSmasq needs to be set up so
it can act as a proxy for the clients.
At this point, I was stuck because I
had no information about the
organization’s existing Internet
connection. On further discussion
with the executive (and to my
horror), I found out that the
Internet connection they had was a
wireless connection that someone
was letting them use. Clearly, this
wasn’t going to work, even with
only 3 clients, they’d choke on a
54g wireless connection. We had a
discussion about getting a wired
connection, and I set up the rest of
the LTSP configuration based on a
wired router we had sitting around
the shop. I also grabbed a 5-port
gigabit switch. Although the router
has 4 ports (in addition to the
Internet port), all the ports were
1 0/1 00, so I connected the router
and all the clients to the 5-port
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gigabit switch. I set the router to
hand out DHCP in the 1 92.1 68.80.x
address range. My
/etc/dnsmasq.d/ltsp.conf file
looked like that shown right.
Again, if you’re building a 64-bit
image, replace i386 with amd64 in
the line:
pxe-service=x86PC, "Boot from
network",
/ltsp/amd64/pxelinux

With dnsmasq set up, it was
only a matter of restarting the
dnsmasq service and booting the
thin clients (or so I thought).
Restart dnsmasq by running:
sudo service dnsmasq restart

I turned on the thin clients, they
started to network boot and
download the Ubuntu MATE image
and I ended up staring at a black
screen… After a bit of research, I
discovered the thin clients actually
had a bit of storage on them, so I
installed Ubuntu MATE directly on
the storage and booted them to
the same result -- it seemed that
these particular clients didn’t like
to work with Xorg without further
configuration. At this point, it was
the last chance I’d get to work on
the system before having to

########################################
# Dnsmasq running as a proxy DHCP
########################################
#
# TFTP
#
#enable-tftp
#tftp-root=/var/lib/tftpboot
#
# DHCP
#
dhcp-range=192.168.80.0,proxy
# Tell PXE clients not to use multicast discovery
# See section 3.2.3.1 in http://tools.ietf.org/html/draft-henry-remote-boot-protocol-00
dhcp-option=vendor:PXEClient,6,2b
# Better support for old or broken DHCP clients
dhcp-no-override
# Enable this for better debugging
#log-dhcp
#
# PXE
#
# Note the file paths are relative to our "tftp-root" and that ".0" will be appended
pxe-prompt="Press F8 for boot menu", 3
pxe-service=x86PC, "Boot from network", /ltsp/i386/pxelinux
pxe-service=x86PC, "Boot from local hard disk"

deliver the news to the executive. I
pulled out an old (but reliable) HP
DC71 00 Pentium 4-based
computer we used to use as public
computers, and set it up to boot
(the first picture in this article
shows the computer with the top
of the case off) from network and
voila, it successfully booted to the
LTSP login screen.
Now I was left wondering
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“what’s the default login username
and password?” Google might be
your friend, but it wasn’t mine that
night until it dawned on me just to
use the credentials I used to set up
the server - and it worked! The
next problem I ran into was that
when I ran /sbin/ifconfig on the
client computer it displayed the I.P.
address of the server. This didn’t
make sense at first because I
thought it should display the an
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address unique to the client. I
thought I’d done something wrong
when in fact things were working
exactly as they should be. Once
the client logs in to the server it
actually is using the resources of
the server and the proxy we set up
was working as it should be. The
clue that things were working
correctly happened when I
rebooted and noticed that each
client does indeed get a unique I.P.
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address that’s displayed in the
bottom right of the LTSP login
screen.

software for the community
centre.

I’ve asked the community
centre executive to keep me in the
loop to help members, and a
After work one evening, I
person of their choosing with
The last problem I ran into was headed to the community centre
training to administer the server.
the fact I was using the LTSP server with one of the executives to
The centre hasn’t officially opened
administrator credentials to log in install the server. The centre had
at the time of this article, so I
to the server. When I went to shut already taken 3 clients. The centre expect I’ll have a lot more to write
down the client, and typed in the
still didn’t have a wired Internet
about in a future article. It’s worth
server admin credentials, I also
connection, but we set up the
noting that I didn’t have a problem
shut down the server. To fix the
network and ran through some of playing sound on clients, but ran
problem I added a nonthe installed programs so they
into issues with USB devices.
administrative account to the
could get their members started
Initially I couldn’t get USB devices
server. Clients would use this non- learning keyboard skills (klavaro, I recognized on the clients. With
administrative account to log in.
found tuxtyping to be too slow on some searching, I managed to fix
But as hinted at earlier, when you
the clients). When the centre gets the problem, but then ran into the
make changes you want
a wired connection, I’ll be revisiting problem of not being able to get
incorporated into your image you
them to reconfigure their server
the drives to unmount without
have to rebuild:
for whatever router is giving them administrative privileges.
DHCP (I’ll add a DHCP reservation
sudo ltsp-update-image
for the server on the router). At
I also tried a system with a Core
that point, it will also be necessary i5 processor as a client, and was
sudo sed -i 's/ipappend
2/ipappend 3/g'
to update the ltsp ssh keys, and
surprised to find that it wasn’t that
/var/lib/tftpboot/ltsp/i386/p update the image:
much faster – slightly faster to
xelinux.cfg/default
boot, but not much of a
sudo ltsp-update-sshkeys
discernable difference running
sudo
ltsp-update-image
software (because the server is
These commands need to be
handling almost all of the load).
run every time you want to rebuild sudo sed -i 's/ipappend
the client image based on a change 2/ipappend 3/g'
/var/lib/tftpboot/ltsp/i386/p
on your server. Remember to
xelinux.cfg/default
replace the i386 with amd64 for
64-bit images. I found myself
It’s exactly the same process for
updating the image several times
updating the image with the
before I got it to a point where I
exception of updating the ltsp ssh
thought I had the right mix of
keys first.
full circle magazine #1 09
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LTSP RESOURCES:
LTSP home page:
http://www.ltsp.org/
Ubuntu LTSP community help:
https://help.ubuntu.com/communi
ty/UbuntuLTSP
Bobby Allen’s blog:
http://blog.bobbyallen.me/201 5/0
7/1 9/setup-a-ubuntu-1 4-04-ltsmate-terminal-server-with-ltsp/
Enabling USB and other local
devices:
https://wiki.ubuntu.com/EnableLTS
P5LocalDevices

Charles is the author of Instant

XBMC, and the project manager of a
not-for-profit computer reuse
project. When not building PCs,
removing malware, and encouraging
people to use GNU/Linux, Charles
works on reinventing his blog at
http://www.charlesmccolm.com/.
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Written by Ronnie Tucker

N

o great, or important, Ubuntu
device news this month. Next
month we will have OTA-1 1 .
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49

contents ^

R E VI E W

F

BQ Aq u a ri s M 1 0 U bu n tu Ta blet

Written by Ronnie Tucker

inally, we get our hands on an
Ubuntu tablet; the BQ Aquaris
M1 0 Ubuntu Edition. The tablet
comes in two flavors (more on that
shortly), and if you pre-ordered it
(like I did) then you also receive a
cover and screen protector.

Both have 1 0.1 ” screens, are
246 x 1 71 x 8.2mm in size, weigh
470g, use a 1 6:1 0 aspect ratio,
have 1 6GB of storage with 2GB of
RAM, micro-SD slots (on the top
edge) with micro-HDMI and microUSB OTG slots on the left side, and,
with them, a headphone jack. The
The M1 0 is, more importantly,
right edge has the power and
the first Ubuntu device (in fact, any volume buttons. Both have
device) which can do the magical
bluetooth 4, accelerometer,
convergence trick that’s so often
ecompass, brightness sensor, GPS,
talked about with Ubuntu Touch.
WiFi (dual-band) and come with
Convergence is, simply put, one
Ubuntu 1 5.04 OTA-9. Upgradable
device that can have multiple uses. to OTA-1 0.1 on first boot.
For example; alone the tablet is
just that (a tablet), but with the
addition of a bluetooth keyboard
and mouse, the OS will adjust
accordingly (giving you a desktop
look) and you now, in effect, have a
laptop. Output the tablet to a
screen and you have the makings
of a desktop machine.

Obviously, they differ in
resolution: the HD has 1 280x800
while the FHD has 1 920x1 200.

Neither come with a microHDMI cable, or OTG cable/hub. So
if you want to try out USB devices,
or hook it up to a screen, you’ll
need to buy some (cheap) extras.

The HD has a MediaTek
QuadCore MT81 63B CPU at 1 .3GHz
while the FHD has an MT81 63A at U PDATES
1 .5GHz. Both have Mali-T720 MP2
GPUs with the HD’s being 520MHz
I mentioned that the tablet
and the FHD at 600MHz.
comes with 1 5.04. While 1 6.04 has
now been released on the desktop,
They also differ with the HD
it’s not available as yet for mobile
rear camera being 5MP, FHD being devices. I’m told that it will come
8MP. Front camera on the HD is
later in the year, but it’s a big job,
only 2MP while the FHD is 5MP.
so don’t expect every desktop
Ubuntu update to appear on your
mobile device. But, don’t worry,
1 5.04 (and future Touch versions)
for mobile devices is still being
looked after and you’ll receive
Over The Air (OTA) updates every
month or two. As I write, 1 0.1 is
the latest update.
Updating is done by simply
going to the System Settings >
Updates, and you’ll see software
and OS updates in here.

SPECS
As stated earlier, there are two
versions; an HD version, and a Full
HD (FHD) version. The HD comes in
white, the FHD in black.

For more on using the OS itself,
see my review of the Meizu MX4
full circle magazine #1 09
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phone. It’s the exact same
software.

SIDE STAGE
A new feature found only on
the tablet is side-stage. This is
where you can have two apps on
the screen side by side. The one on
the right is overlapping the one on
the main screen.
This is done by opening the app
you want at the right side of the
screen then, with three fingers,
dragging the app to the right of
the screen. As soon as you move
your three fingers across the
screen you see a drop zone for the
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side-stage app.
Obviously, how well an app
looks in side-stage is up to the
developer. So don’t worry if things
look a bit odd at first. It’s a handy
feature to have your email (in
Dekko), or the File Manager,
always there at the side of the
screen.

CONVERGENCE
Adding a keyboard and mouse
is when the magic starts to
happen. The Ubuntu Touch OS
switches into what it calls
‘windowed mode’ where your
scopes/apps become windowed
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and everything looks more like the
familiar Ubuntu.
You now effectively have a
laptop.

I should also mention that
plugging in an OTG cable/hub with
a USB mouse/keyboard will trigger
the desktop mode too. I also tried
a wireless keyboard/mouse with
USB dongle and it worked fine too.
Heck, I even tried a gimmicky
bluetooth laser projection
keyboard and it worked!

Pushing the mouse to the left
edge of the screen will show the
Unity side strip with the Ubuntu
(ie: home) button and the apps you
have open, or have pinned to the
Speaking of desktops…
side. Pushing to the right brings in plugging in a micro-HDMI to HDMI
the switcher to let you choose
cable between the tablet and a
other open apps (or to close apps). TV/monitor will pop the tablet into
its third mode. This is the same
And, in short, you use the apps display as the laptop/windowed
like you would if it were a
mode, but now you’re using a
desktop/laptop.
bigger screen. The reason it’s a
third mode is that the tablet

full circle magazine #1 09

52

contents ^

REVIEW - BQ AQUARIS M1 0 UBUNTU TABLET
screen now goes blank (your
display is on the TV/monitor) and
the tablet screen now becomes a
touchpad.

You can, if you want, keep the
mouse/keyboard attached and
have all the bells and whistles you
could ever want.

that you do need to install the File
Manager from the Ubuntu Store
(for free) and unlock the File
Manager (from its menu) to gain
read/write access to the stick.

This is also a good time to say
that not all USB hardware will
work. Some draw too much power
from the tablet and just won’t
work. I tried my Wacom tablet,
In one of my photos, and I
and, while it lit up, it wasn’t
apologise about the quality of
them but it’s very difficult to photo recognised. Also bear in mind that
a TV/tablet, you’ll (hopefully!) see if a USB device does work, it may
drain the battery very quickly.
a USB stick plugged into an OTG
hub which is plugged into the
tablet (which also has the
LEGACY APPS
keyboard/mouse dongle). While
you can use USB sticks, be aware
But the tricks don’t end there.
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There’s more!
Pre-installed on the tablet are a
couple of (what’s known as) legacy
apps. The apps are fully working
versions of GIMP, LibreOffice,
Firefox, Gedit and Gchat desktop
apps!
That’s right. You can use fully
functioning GIMP, LibreOffice, etc.
on the tablet.

NOTE: as of writing, and OTA-1 0.1 ,
there is a bug whereby the legacy
apps can’t use the on-screen
keyboard and need a hardware
keyboard. This is a known bug and
is being worked on.
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One quirk of legacy apps is that
they’re, for want of a better term,
sandboxed. So, for example, they
can’t see USB sticks. This means
you need to save your LibreOffice
document to the tablet then
copy/paste it to the USB stick in
the File Manager. It’s a bit of a
nuisance, but nothing major.
I haven’t tested plugins in GIMP,
but I did try addons with Firefox
and the addons installed, and
worked exactly as expected. While
on the subject of Firefox, things
like YouTube and Vimeo in Firefox
are very stuttery, but fine (even at
full screen) using available apps
from the store. Netflix is,
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unfortunately, a no go.

SUDO APT
I know what you’re thinking:
great! So I can sudo apt my
favourite software on the tablet?
Uh. No. The tablet uses the
ARM processor. In short: it won’t
run bog standard desktop apps
without them being possibly
rewritten, recompiled and/or
repackaged.
If you should happen to have an
app that’s ARM compatible then

I’m told that OTA-1 1 will bring a
way to install it using a nice GUI
app on the tablet.

CONCLUSION
Pros

• Lovely looking tablet.
• Side-stage handy for keeping eye
on email/etc.
• Convergence is great. One tablet,
multiple uses.
• Works well with OTG hubs, USB
(kb/mouse), Bluetooth devices,
etc.

Cons

• No sync between devices. The old
Ubuntu One cloud storage would
have been handy now.
• No file/document manager by
default. You need to install them
from the store.
• As of writing, the legacy apps are
a bit slow.
• Can’t install any old app.
• Charging can take a couple of
hours. Even from the mains.
• Small text in desktop apps.
The M1 0, and convergence, are
great ideas, but non-geeks might
be better waiting for OTA-1 1 +.
Having no file, or document,

manager by default seems a bit
odd as they’re something most
people would need. Thankfully
they’re only a few pokes away in
the Ubuntu Store.
I do hope they can get more
speed into the legacy apps as
they’re a bit slow. Having said that,
I did load up one of my larger,
multi-layer, GIMP files, and it was
completely usable and I could still
apply complex filters quite quickly,
considering it’s a tablet.
Not being able to install just
any desktop app will definitely be a
deal breaker for most people, so I
hope there’s some easy, or easyish, way that this can be rectified.
All in all though, I’m still very
happy with the tablet. I’m looking
forward to future updates as, like
the phones, it can only get better.

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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P yth on Cra sh Cou rse

Written by Greg Walters

sheer size of the book (528 pages)
was, at first, a bit daunting because
many books this size are on a level
that is either so full of disjointed
facts, thoughts and ramblings that
it is dryer than the Sahara and one
has to be an archeologist to dig out
the information, or written in such
a way as to come very close to
insulting the reader's intelligence.

Python Crash Course: A Handson, Project-Based Introduction to
Programming
By Eric Matthes
January 201 6, 528 pp.
Publisher: No Starch Press
ISBN: 978-59327-603-4

T

his book came to me just as I
was having multiple physical
issues and after two ER visits, one
surgery and some recuperation
time (and issues), I’m finally
getting to finalize this review. The

Happily, Eric didn’t produce
either of these types of books, but
one that balances between the
two. The layout of the material is
well done. Part 1 gives more than
the “normal” basics of Python
programming in some 230 pages,
which includes setting up the
programming environment for the
basics, all the way to writing test
cases and code in a very clear and
logical manner.
Eric’s Project-based section
includes such things as using
PyGame to create a game like Alien
Invaders, using matplotlib and
pygal for data visualization, and
creating web-based applications
using Django. All of these projects
are well thought out and
full circle magazine #1 09

presented in such a way that
learning the subject matter and
implementing it is much more an
enjoyable pastime rather than an
onerous task that must be
completed. Eric took the time to
deal with some rather complex
projects and lay them out in a
consistent, logical and pleasant
manner that draws the reader into
the subject willingly, which
unfortunately, many authors fail to
do.
In Eric’s Appendices, he covers
various text editors, how to get
help, and using GIT (something I’ve
been meaning to discuss for years,
but never quite got there, so BIG
THANKS, Eric).
All in all, I have to give this book
a 5 out of 5 star count! I’m happy
to include this into my private
library for a very long time.
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

servers; I use the one from Kent
University-UK providing download
’m a relative newbie to Linux. I've speeds as usual from elsewhere (in
the UK). I was advised about the
played around in older versions
of Ubuntu. However, I am yet to be mirror servers via the Deepin
Forum site.
admitted to the inner sanctum
where phrases such as SUSE,
Frank Dinger
Debian, REDHAT, Grub, Unity, GNU,
and many others, are used with
unquestioning authority. However, BQ M1 0 TABLET
to me they may as well be in
Klingon as they are just so much
ust viewed the YouTube on the
gak to me. Maybe an introductory
BQ M1 0
‘Dummies’ article would help
(https://www.youtube.com/watch?
demystify some of these terms and v=6LGmq38G0to). I just received
I’d feel more at home here. While
one this week. It is everything you
my Unix background is helpful, (a
say! One more plus: I live in the
long time user of fruit-inspired
USA in central Ohio, and received
products) there is still much to be the M1 0 shipped from Spain in less
learned.
than a week from the day I ordered
it. And the shipping was free. The
Owen McCarthy
unit with Duo Case and 2 screen
protectors cost me 299 Euros or
about $330 – a bit pricey for a
D EEPIN M IRRORS
Tablet, but I am a fan of the Linux
OS and want it to prosper.
ust a short comment on the
Deepin OS review: Yes, the
I bought the M1 0 for my wife.
downloads from the "Deepin
Technology Ltd" servers (I believe Neither of us has used a Tablet,
in Shanghai) can be anciently slow. but the large cumbersome
Windows 1 0 laptop she uses is
slow and, for her, confusing. She's
However, there are mirror
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J
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finding the M1 0 has a relatively
brief learning curve even though
she's not a cyber whiz.
I've been an Ubuntu fan, though
no Linux expert/nerd, for a few
years now. For my desktop, I'm
using a MintBox2 I got from an
Israeli manufacturer. My laptop is a
used Dell E641 0, I bought cheap,
on which I also use the latest Mint
version. I've yet another old
Toshiba NB505 that I'm using with
a new installation of the latest
version of Lubuntu. This minimalist
Ubuntu works really great on a
machine without much to offer.

Ron Payne

VOICE I NTERFACE?

I

would like to use voice mainly as
the interface with a computer.
Any progress on using Cortana,
Siri, Google or other bots on
Ubuntu? A simple request that
would probably need a vast
amount of work.

Tom
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Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

I was finally able to get a
Q separate
(third) drive for

Ubuntu. What I would like is, every
time I turn on the computer, I get
the option of which OS I boot into.
I think the solution is to use a
bootloader, but I have no idea how
to pick one or even know if this is
right. I have Windows 1 0 and
Ubuntu 1 5.1 0.

A

When you install Ubuntu, it
will install the GRUB
bootloader. If you choose
"something else" during
installation, you can specify where
it should go. Select the first drive
in your BIOS/UEFI boot order. You
will need to use the drive sizes to
figure out which drive is which.
Probably the one with Windows
will be first, identified as SDA.
Probably Ubuntu will go on the
third drive, SDC.
Since it is very easy to get this
wrong, make sure you have an
image backup of your system, and
a way to restore the image, before
you do anything! Macrium Reflect
Free is a good program for doing
this.

I've just upgraded one of my
Q machines
to 1 6.04, and now,

on installing Folding@Home, I get
a Python error.

A

(Thanks to khowe in the
Ubuntu Forums) wget
http://launchpadlibrarian.net/1 090
52/python-support_1 .0.1 5_all.deb
sudo dpkg -i pythonsupport_1.0.15_all.deb

Not sure why it doesn't install
automatically, maybe a bug report
is in order.

You will see a list of the
partitions on your hard drive.
Select the one where LXLE resides
and click on "change." Specify "use
as" EXT4. Select the mount point
"/" (root) and click on the box to
format the partition, and OK.
I have been trying to run
Q Picoscope
under Wine,
unsuccessfully.

A

See this page:
https://www.picotech.com/do
wnloads

I have a dual boot system,
Q Windows
7 and LXLE. Can I

It says there is a picoscope for
Linux. Since you need drivers for
the computer to get data from the
'scope, there is almost zero chance
you would get it running in Wine.

A

upgrading to 1 6.04, I
Q wasWhilstinformed
that removing

toss out LXLE and put Ubuntu
Mate on my machine?

During installation of any
member of the Ubuntu family,
you will reach a point where it asks
where you want to place the
installation: erase disk, alongside
the existing system, or something
else. Select something else.
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old packages may take several
hours. I didn't take the removal
option at the time as I didn't have
the time to wait. Is it advisable to
remove them and if so how do I do
it?
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A

(Thanks to deadflowr in the
Ubuntu Forums)

sudo apt-get autoremove

will show all packages no longer
needed. I think apt's man page
makes a nice point about whether
to remove or not to remove.
cameras
Q andI havewouldtwo likesecurity
to know if I can

attach them to my network and
use some kind of software on my
server machine to record the
video. Also a way to remotely view
it on an iPhone.

A

(Thanks to volkswagner in
the Ubuntu Forums)
Zoneminder works with most IP
cameras (need to send mpeg
stream).
There is a paid app (zmNija) in
Android and Apple app stores, that
integrates well with ZM. You'll
want to use the Ubuntu PPA for
use of zmNija.
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Q&A

Is Synaptic package manager
Q installed
by default on Ubuntu

using sudo. Then run the same
command.

A

TOP QUESTIONS AT
ASKUBUNTU

Mate version 1 6.04?

No, but it's easy to install
post-installation of Mate.

Q

I clearly remember
downloading different debs
and just click installing. This is not
working for me anymore.

A

Install Gdebi and use it to
install .deb files.

I have a pack of fonts which I
Q would
like to add to Ubuntu
1 4.04. How can I do this?

A

(Thanks to CantankRus in the
Ubuntu Forums) If you have
only one user, you can place them
in ~/.fonts

* Is there any program for fuzzy
string matching, which provides a
match score?
http://goo.gl/xnLFAf

If you want to make the fonts
available to multiple users, you
need to put them in
/usr/share/fonts which requires

* No more boot logging since
1 6.04?
http://goo.gl/r4RuvP
* Personal computer hacked: How
do I block this user from logging in
again? How do I find out how they
are logging in?
http://goo.gl/A39P3E

* What is the 'Badlock Bug'?
http://goo.gl/9wcaL1

TIPS AND TECHNIQUES

* What is the name of the security
concept that explains why Linux
asks for root password?
http://goo.gl/Fi0ehH

Really?

* How do I install and manage
GNOME Shell extensions?
http://goo.gl/sx3ES3

* Why doesn't the latest Ubuntu
edition come with the latest stable
That folder probably does not
exist, so you have to create it. Then Linux kernel version?
http://goo.gl/N8748p
run this command:
sudo fc-cache -fv

http://goo.gl/zdG27C

* How to run a Python program
directly?
http://goo.gl/vjHloF
* Ubuntu Server 1 6.04 installs on
/sdc but fails to boot
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A

s my bio says, I work part time
in a mostly Windows
environment. It's an accounting
firm, and the typical desktop
system has nearly 200
"applications" installed; all of them
are Windows only. A new client
walks in and says, "I haven't filed a
tax return for a dozen years, and I
have income in both Canada and
the U.S." That's 24 "applications"
right there.
The company has aligned itself
with two primary software
suppliers. This makes tremendous
sense, and simplifies the IT
workload.
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One of the software suppliers
has a no-charge add-on to its
mainline product, which is very
attractive. It's a "portal" for
transferring files between clients
and the firm, and it ties in nicely to
the main product. When a new
client asks, "how can I send you
files," having a standard answer is
very powerful.
The software is free. However,
the suggested configuration is to
have a separate server in its own
"DMZ", which means a new router,
a new computer, a new Windows
Server license, a new domain name
and a new SSL Certificate. The
most expensive part of this? The
Windows Server license! Argh!

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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Q &A I I : TH E XEN I AL L AU N CH

Compiled by Gord Campbell

Ubuntu, while others could delve
ichael Kaulback hosted an
Ubuntu launch party on April into the internals.
21 in Toronto, Canada.
Almost half the people brought
computers, most of which were
In addition to providing
cupcakes and coffee, Michael (who five to seven years old. Based on
is genii on IRC) proved his chops by this small sample, it seems that any
old computer with at least 2 GB of
helping to install Ubuntu 1 6.04,
Xenial Xerus, on a nasty little X86- memory can run any member of
the 'Buntu family reasonably well.
based tablet.
About 20 people attended, with For more pictures:
a range of interest levels. A couple https://goo.gl/photos/FfUmX1 i54R
z2kncL6
were merely considering using

Photo caption : John Kerr (left) and Gord Campbell represented Full Circle Magazine at
the Toronto Xenial Xerus launch party.
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U B U N T U G AM E S

Sku llg i rls

Written by Oscar Rivera

O

ver the last couple of years,
Linux gamers have gotten
quite the flurry of games ported
over to Linux, and lately, some
games have even been released for
Linux at the same time as they're
released on other consoles.
However, not a single true fighting
game had been made available for
Linux users until now.

Linux. The game runs as smoothly
as any other Linux native game,
which was something of a concern
for me when I heard that the
original game developers were not
involved in the Linux port. It was a
small number of volunteers and a
yet-to-be-named company who
made the Linux port – not only
playable and enjoyable but also as
perfect as it could get. On behalf
of the Ubuntu gaming community,
I'd like to thank you.

Move over Street Fighter and
go chill with Mortal Kombat and
your other pals, because Skullgirls
Anyone who's played titles such
has arrived! Skullgirls is a 2D
as the aforementioned Street
fighting game developed by
Reverge Labs (later renamed Lab
Zero due to some financial and
legal issues). It was originally
released in 201 2 for Xbox360 &
Playstation 3, then, in 201 3, it was
released for Windows PC. Lots of
Skullgirls fans, myself included,
kept requesting a Linux port, and,
in October 201 5, it finally arrived
on Linux as well as Mac OS X. The
game was ported by a few
dedicated fans who worked hard at
making it available on Linux, but,
after playing the game, you could
never guess that the game was not
originally intended to be played on
full circle magazine #1 09

Fighter, Mortal Kombat, or other
fighting titles, will feel right at
home playing Skullgirls. The game
provides various modes of play
depending on your needs. There is
a single player campaign storybased mode, an arcade mode, a
training room, and a single player
versus, as well as a two-player
versus mode that can be played
online. I have played all of the
different modes available, and
there are very subtle differences
between them. The online versus
mode is fun because you get to
play against another player, but I

would recommend going through
some of the tutorial, single player
versus (or arcade), or even the
story mode first, if you're planning
on not getting badly beaten right
away. Some of the players you'll
encounter online on a good day are
quite good; however, other times
there may not be as many players
available online due to the game
having had its initial release so
long ago. The tutorial as well as
the training room are great at
learning and then improving your
skills. Also, for some odd reason, if
you decide to use a game
controller, the button layout is
rather unorthodox and it may take
some time getting used to it (the
same holds true for all other
consoles as well as PC/Mac
versions). It's almost like some of
the control layouts are slightly
counter-intuitive, but once you get
used to them, they are not that
hard to use and understand.
Skullgirls can currently be
bought through Steam or through
the Skullgirls website for around
$9.99 at the time of this writing.
There are a total of eight playable
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characters in the standard edition
(yes, all of them girls). If you want
to buy the Skullgirls 2nd Encore for
$1 4.99, then you get an additional
five characters as well as all sorts
of other added goodies. The five
added characters can also be
bought separately for $1 .99 each,
which would be an additional $1 0
for all five characters. By buying
the Skullgirls 2nd Edition, you not
only end up saving $5.00, but you
also get a few added bonuses – so I
would recommend paying a bit
more for the 2nd Encore to get
your money's worth. Some of
these added characters are girls,
but some (such as Big Band and
Beowulf) are not. Like all fighting
games, each character has its own
way of doing the basic moves (low
kick, mid kick, high kick, low block,
mid block, high block, etc). But,
more importantly, each character
has its own set of special moves
which you'll have to memorize if
you want to be able to perform
them at will instead of by chance.
It's not terribly hard to perform
special moves; it just takes some
time to get used to the button
combinations for each character.
The story mode (as well as all
other modes for that matter)
revolve around the Skull Heart and

the power it can grant its owner.
All eight Skullgirls are trying to get
the Skull Heart back from Marie
who is the nemesis of the game. I
first started with the tutorials,
then went on to the arcade, story,
and finally versus and versus online
modes. The story mode tells you a
little bit about each character's
past and why she wants to acquire
the Skull Heart from Marie. The
seemingly hand-drawn characters,
as well as the intricate background
art, in combination with the fast
jazz-meets-punk spy music, have a
certain quality to them that adds
to its post-prohibition, cyberpunk,
feel – which is reminiscent of the
James Bond and Operation:

Impossible fictitious eras.
Surprisingly, I have not come
across any deal-breaking glitches
yet. I say surprisingly because it's
my understanding that the Linux
port was initially begun by a small
number of Skullgirls fans and
finished by a still unknown
company. The only negative aspect
of the game I would say has
already been worked out with the
2nd Encore additions. Many
people, myself included, used to
complain about a short storymode, and a lack of playable
characters, but for only $5 more,
that issue has now been resolved. I
still strongly believe that for the

low price of $1 4.99, you get a good
quality fighting game with lots of
replay value even after completing
the story and arcade modes.
This is a game that I most
definitely recommend if you're
looking for a fighting game,
especially since as of now Street
Fighter has only been promised
but not yet delivered. You will not
regret getting this game unless

you object to the outfits the girls
are wearing in the game.

Minimum System Requirements:

OS: Ubuntu 1 5.04 / Fedora 22 /
SteamOS
Processor: Dual-core CPU
Memory: 2 GB RAM
Graphics: Intel HD3000*
Network: Broadband Internet
connection
Storage: 5 GB available space
Additional Notes: *MESA drivers
1 .6.0 and 1 .6.1 are not supported,
please update to 1 .6.2.
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CHA CHA CHA CHANGES
Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.
The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page that I’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.
Several people have asked for a PayPal
(single donation) option, so I’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/
fullcirclemagazine
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Full Circle Team
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 05th June 201 6.
Release :
Friday 24th June 201 6.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Most editions have a link to the epub file

on that issues download page. If you have any problems
with the epub file, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the
RSS feed: http://fullcirclemagazine.org/feed/podcast

Issuu - You can read Full Circle online via Issuu:

Or, if your out and about, you can get the Weekly News
via Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-CircleWeekly-News-p855064/
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Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org

http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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